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Introduction 
 

I am introducing the very basic QGIS tutorial, which is mostly dedicated for people, who are planning to 
use this software just only for viewing, reading, and exporting the GIS content, which has been already 
prepared by anyone else.  QGIS is widely used tool, which includes a vast number of issues for 
explanations. Most of tutorials look rather like books, which stresses the wealth of features offered by 
QGIS. This short guide should help you understand what QGIS is and how can it help you to read any 
content properly and apply it in other ways. By knowing how to surf between various GIS layers you will be 
able to understand the QGIS better. The level of knowledge presented in the following document covers 
pretty much the entry level of QGIS knowledge. The whole guide is based on 3.12 version. Some options 
and solutions have been omitted due to community to which this tutorial is dedicated. I tried to omit 
advanced features and keep this document as much succinct as possible. 
 
Blue text – important things to know 
Red text – very important things 
Italic dark blue – QGIS things 
Italic dark blue bold – important QGIS things 
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1. Installation of QGIS 
 

Installation can be done by visiting the website https://qgis.org/ where you can always find the most up to 
date QGIS version.  

Under the “Download button” you can see two 
latest versions of the software. The top one is 
usually “The reachest features”, the second one 
is “Most stable” as it exists for a longer time, 
which allows contributors to remove some 
unforeseen bugs. After clicking “Download 
Now” and selecting the version we want to (as 
well as the directory), we must wait until the 
QGIS installer is downloaded on our drive. Its 
weight is about 1GB, so it might take longer 
than usually expected. At the end we should see 
the QGIS installed by appearance on the list of 
our Windows Start menu. 
If you are unhappy with the newest QGIS 
versions provided, due for whatever reason i.e., 
slowing down your computer, you can always 

try with older versions, which are available on this website: 
https://gisenglish.geojamal.com/2018/08/download-old-qgis-software-and-all.html 
However, it’s not advisable back further than version 3.0, because of a serious upgrade, which took 
place at that moment. In turn a lot of plugins have been incorporated in the QGIS toolbox, therefore 
they aren’t compatible anymore as separate units. 
If you are interested in further releases, which are planning in the foreseeable future, you can check 
this list out: 
https://qgis.org/en/site/getinvolved/development/roadmap.html 
 

2. Choosing the project 
 

Pic. 1 QGIS Main website with download options. 

Pic. 2 Selecting (creating) the new project in QGIS. 

https://qgis.org/
https://gisenglish.geojamal.com/2018/08/download-old-qgis-software-and-all.html
https://qgis.org/en/site/getinvolved/development/roadmap.html
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At the very beginning of your adventure with QGIS you will have to select the project. It’s not a big 
deal, especially that the tool leads you intuitively to the proper bar (Pic. 2). 

3. Getting around with QGIS interface 
 

A. Panels 
 

Panels in QGIS are located on the left, and 
right-hand side. Like you see below, there 
are example panels available, which can be 
changed (switched on/off) at the same 
basis as toolbars described below. We 
should go View -> Panels (Pic. 4) or right-
click anywhere in the main toolbar area. 
Each panel box has the characteristic cross 
“X”, to close it down.  

Pic. 4 Switching on/off panels in QGIS. 

Pic. 3 Panel location in QGIS interface. 
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Next to it on the left we can find the 
double-box which unfreezes our panel box 
from its placement in QGIS. 
In fact, when you move it just slightly, the 

QGIS will still keep the blue space reserved 
for this box to come back. Moving it further 
across the map canvas, this area 
disappears, and it’s filled out by other 
panels optionally. The panel window can be 
moved by holding the header next to the 
“X” symbol. 
The most important panels from the 
browser’s point of view can be: “Layers”, 
“Layer Order” and “Browser”. The last two 
appear in the one panel as separate tabs. In 
the further chapters the usage of them is 
fully explained. 
 
 

B. Toolbar 
 

In default your major QGIS panel looks poor, like you can see below. There are just basic options 
available, which number tend to increment as we install some new plugins.  

In fact, there is an option, which allows a user to manage with various toolbars quickly depending 
on the situation. It’s just a simple way of how we can do it.  

 

 

Pic. 5,6 Moving out the panel box from its default position. 

Pic. 7 The default toolbar in QGIS or pretty much like this. 

Pic. 8 This is how the main toolbars looks like when all toolbars are active (including toolbars of plugins installed). 
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In your main panel select View -> Toolbars and thick on which one you want to use for your 
project. I guess for viewing you won’t need them that much. The most important for you might 
be “Help Toolbar”, “Manage Layers Toolbar”, “Multiple selection” etc. 
 

C. Status bar  
 

 It’s a bar placed at the very bottom of QGIS interface. We have some options there, which include 
mostly the view-based features to be discussed further in this document. 

 

Pic. 9 Switching on/off toolbars in QGIS. 

Pic. 10 The status bar in QGIS interface 
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D. Main view (map canvas)  
 

 Admittedly this is the rest of our interface, the biggest section, in which our QGIS work is visible.  
 

4. Plugins installation 
 

QGIS has a lot of tools in its core, where most of them were former plugins functional in the 2x versions. 
This is the section, which keeps this software vital. Every new version brings some new functionalities in 
the core toolbox. We cannot forget that some plugins are updated or created even more often than 
scheduled QGIS upgrade. There are over 800 plugins available in QGIS dedicated for various type of work. 
From the browser’s point of view just a little of them can be utilised in a day-to-day basis, but it will be 
vital to know how to manage and install them successfully. 

The basic way of installation of any plugin is using the “Plugins” section in the main toolbar as presented 

in the images above. Installation is straightforward itself 
because you just need to hit “Install plugin” button. If 
the plugin has been already installed earlier in your 
QGIS software, the button changed to “Reinstall 
plugin”. Another thing is the appearance of any plugin 
installed. We need to make sure, that access to it is easy. 
Usually on instant way any plugin creates its additional 

options available both in 
the main toolbar (like 
MMQGIS) or in the 
“Plugins” and “Web” 
dropdown menu. 
Moreover, they can be 
found as additional panels 
or toolbars described 
earlier (Pic. 2, 3). One of 
the toolbars is called 

Pic. 11, 12 Installation and browsing plugins in QGIS. 

Pic. 11 An example of plugins toolbar. 

Pic. 13 The way of how we can switch on/off the plugin in QGIS. 
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simply “Plugins toolbar” which includes some signatures of installed plugins (Pic. 13). Another option is 
adding plugins to QGIS externally, by downloading them and unzipping. This option can be found in the pic. 
9 (Install from ZIP), although it’s not necessary just for browsing purposes. Each plugin can be simply 
switched off without uninstallation. It’s just unticking the box next to the plugin name/logo as shown above. 

5. Basic map 

 

There are 2 ways of how we can load the map tiles into QGIS. I usually use the solution shown above. 
In your “Browser” panel there is a section called XYZ tiles, from where you can pick up the map you 
want to. Regrettably the default settings don’t offer any choice at all. You can only run the 
OpenStreetMap canvas by double clicking, drag & drop or selecting “Add layer to the project” after 
right-click. However, if you would like to have the list expanded as shown in the image above, you 
can use some links below: 

Map canvas URL 
Google Roadmap http://mt0.google.com/vt/lyrs=m&hl=en&x={x}&y={y}&z={z}  

Google Hybrid http://mt0.google.com/vt/lyrs=y&hl=en&x={x}&y={y}&z={z}  
Mapy.cz https://mapserver.mapy.cz/turist-m/{z}-{x}-{y} 

OpenTopoMap https://tile.opentopomap.org/{z}/{x}/{y}.png 
 

Google Satellite https://www.google.cn/maps/vt?lyrs=s@189&gl=cn&x={x}&y={y}&z={z}  

These links represent direct connection to the custom map tiles offered by their major provider 
(Google Maps, OpenStreetMap and so on). We must connect the XYZ layer with one of them like 
shown below: 

Pic. 14 Launching the base map canvas in QGIS. 

Tab. 1 Examples of XYZ (map) tiles, which can be linked to QGIS. 

https://mapserver.mapy.cz/turist-m/%7bz%7d-%7bx%7d-%7by%7d
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Another way seems to be easier 
for the QGIS novices and more 
beneficial in terms of the range of 
map canvas provided. This is the 
QuickMapServices (QMS) plugin, 
which can be installed from the 
plugins panel presented earlier 
(Pic. 16).  
There is also another method, 
which would allow user to load 
the map tiles quite smoothly. 
There is the Tile+ plugin, although 
its installation requires unzipping, 
therefore surely it won’t be the 
first port of call for someone 
completely new to QGIS.  
I assume, that loading your map 
canvas came without any 
problems. Your map appears in a 
major part of QGIS interface and 
all of us are happy. However, it’s 
beneficial at this stage to explain 
some things. Firstly, it’s vital to 
know some hot keys, which make 
a nice shortcut for our work.  
By using the mouse, you can 
zoom in and out. It happens so 

quickly. In order to have the zoom level changes under control we can keep the Ctrl when scrolling 
our mouse. The full specificity of hot keys used for browsing the main map is listed in the table below 
(Tab. 2). 

Hot Key Action 

Mouse scroll Zoom in/out of our map - quickly 

Ctrl + mouse scroll Controlled zoom/in of our map 

Ctrl + Shift + F / PgDn Zoom map to full extend 

Much more about shortcuts will be discussed in the next chapter. The map canvas has other curious 
options like wide-understood customizing. We can fetch the random map tile to our project or even 
more than 1. They are in fact quite heavy but can be useful simultaneously when needed.  

Pic.15 Connecting XYZ map tiles to QGIS. 

Pic.16 Launching the QuickMapServices plugin in QGIS. 

Tab. 2 Hot keys for general QGIS map canvas 

Pic. 18 Customizing map coloration 
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Every individual setting applied here goes straight to print layout or export map as the image, which is 
further discussed in this document. Apart from the coloration important is the map transparency, which 

might be useful especially for overlays i.e., with satellite imagery (Pic. 19). 

6. Coordinate Reference System (CRS) 
 

Coordinate Reference System (CRS) is used for the projection of our map. As you probably were at 
the very beginning, the map loaded into QGIS has some default projection. Obviously, it must change 
to fit your project requirements. The default CRS projections are EPSG:3857-WGS84/ Pseudo-
Mercator and EPSG:4326 – WGS 84. The default configuration, which allows maps and layers to work 
properly is the EPSG:4326 as the project CRS and EPSG:3857 for the map canvas CRS. 
There is a lot of CRSes available, which are dedicated locally. For example, in the case of Great Britain, 
most used is EPSG:27700 – OSGB 1936 / British National Grid. Changing the default project CRS to 
the CRS we want to use in our work requires conversion of coordinates between two CRSes, which is 
done automatically by QGIS application. We must remember that proper CRS defines the individual 
coordinate system visible in the status bar, about which I write you later. Another consequence of 
use the specific CRS is the compatibility with displayed maps and layers. If, for instance we use the 
EPSG:27700 – OSGB 1936 / British National Grid we shouldn’t expect to have OpenStreetMap layer 
displayed correctly, since it’s based on WGS84. When CRS system of the map will be different than 
the CRS of our layer, the vector layer will be placed “at the beginning” of the used coordinate system, 
which for WGS84 means Lat 0 Lon 0 (Guinea Bay) and for British National Grid accordingly X 0 Y 0 
(westernmost part of English Channel southwest of Isles of Scilly).  

Pic. 19 Setting up map canvas transparency 
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The same applies for all layers you want to include in your project. Their CRS must correspond to 
project CRS if we want to have them working properly.  

Pic. 20 An example of conversion between two CRS systems. 
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7. QGIS Hot keys 
 

The matter discussed a bit earlier refers to the keyboard shortcuts, which can be used in QGIS. 
There are a few sets as default so far, although every user can adjust them to the individual 
demand.  

You can find them by clicking Settings -> Keyboard shortcuts in the main panel. Next find the one 
you wish to use frequently and hit the “Change” button. Next the button will turn into “Input:” 
waiting for your keyboard turn. Once you hit some key it will appear instantly on your right. When 
some shortcut has been already assigned you should see the alert asking you about the reassigning. 
Often keyboard shortcuts are visible just next to some option like Save Edits (Ctrl+S) and so on. 
 

8. Menu Bar 
 

Menu bar is located at the very top of our QGIS interface. Right above toolbars discussed earlier. 
Menu bar in other words is a list of tasks, which can be applied to typical work in QGIS. This section 
is expandable by additional options, which come out right after some plugin’s installation. For entry 

Pic. 21 Keyboard shortcuts settings in QGIS. 

Pic. 22 Relation between some sections of menu bar and toolbars below. 
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level in QGIS it’s good to remember that some sections of menu bar are replicated as separate 
toolbars beneath. It’s good to know it, because you can avoid a frill expands of the sections and use 
the proper icons straight away, which I am going to explain in the next section. The graphical example 
is shown above (Pic. 22). 
 

9. Toolbars 
 

Let’s go through the status bar now. We have them a few in a default option, which should require 
attention for new QGIS users. 

A. Project toolbar 
The project toolbar looks as follows (Pic. 23). We have 
effectively 6 options there, although not all will be used by 
the new user of QGIS. Let’s see which one might be 

important: 
1 – New Project – creates the new project. 
2 – Open Project – opens already existing project saved in 

our directory. 
3 – Save Project – saves our project. Remember, that saving the project in QGIS does not 
guarantee saving layers we are working on! By saving project we are freezing our current level of 
work with regards to layer appearance, layer orders, grouping, etc. If you have forgotten to save 
edits in your particular layer, they won’t be restored! 

4 – Create a new print layout – nice shortcut for creating print layout, which usage is to be 
discussed later in this publication. 
5 – Show layout manager – opens a list of already existing print layouts if they exist at all. I 
assume, that you will have nothing there as you are beginning your adventure with QGIS. 
6 – Style Manager – it’s a quite advance option, which is tailored for organizing style items. You 
can read more about it here: 
https://docs.qgis.org/3.22/en/docs/user_manual/style_library/style_manager.html 
 

B. Map Navigation Toolbar 

Map Navigation Toolbar is usually the adjacent toolbar on the right of the previous one. There is 
a dozen or so useful options, which act as the handy shortcuts in our managing with the main 
map canvas. Let’s explain them all: 
1 – Pan Map – it’s like a “hand” cursor, which basically switches off all other options applied (like 
editing, creating vertices and so on) and allows a user to pan and dragging the map canvas 
wherever he wants to. 
2 – Pan map to selection – centres our map where the selection has been made. It works for any 
layer and multiple selections too. The zoom level is based on the selection range. Selection will 
be explained later in this guide. 
3 – Zoom in  

Pic. 23 Project Toolbar with all options 

Pic. 24 Map Navigation Toolbar with all options 

https://docs.qgis.org/3.22/en/docs/user_manual/style_library/style_manager.html
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4 – Zoom out – both Zoom in and zoom out can be superseded by mouse scrolling (alternatively 
mouse scrolling + Ctrl) as explained in the chapter 5. 
5 – Zoom full – this option pans map to our whole project. It means, that the zoom is based on 
the range of the most robust layer. In turn our whole work is visible in one go. 
6 – Zoom to selection – close-up view at the items, which have been already selected. 
7 – Zoom to layer – setting up the map view, which covers the view of a whole layer already in 
use. It applies to every layer selected in the “Layers” panel, which is highlighted in blue. 
8 – Zoom to native resolution – it works just for map canvas (XYZ) tiles and acts like the zoom-
out option. 
9 – Zoom last – brings a user to the last zoom level. 
10 – Zoom next – moving a user to the further zoom level (after Zoom last have been applied). 
11 – New map view – very handy option, which creates the new map view. In this case we have 

a possibility to work with multiple map canvas, which I am going to explain you a bit later. The 
new map view can be placed in one of the side bars and act like the overview map for our project. 
We can see there how our cursor moves and where we certainly are, which is beneficial for a 
close-up view (Pic. 25). 
 

Pic. 25 An overview map as an example of new map view added to our main QGIS interface. 
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12 – New spatial bookmark – the option, which can save our current zoom level at the specified area 

and help us to back to this view 
instantly later. By opening the 
dialog window, we can decide 
what the spatial bookmark should 
look like. We can define the 
bookmark by the following 

criteria: 

- current map view 
- map canvas extend, 
Last thing is saving our map in the 
bookmarks catalogue. 
13 – Show spatial bookmarks – if 

you have any, they will appear in 
the Browser panel. Basically, this 
button does nothing apart of 
expanding the folder tree in your 

“Browser” panel where all the 
spatial bookmarks are located 
(Pic. 27). 

14 – Refresh – updates our current map view 
 

C. Attributes toolbar 

This is another useful toolbar, which should 
come as the default is concentrated on the 
layer content, which user can manipulate on 
the map. We can find there some options, 
which are treated separately in this tutorial, 
therefore I will skip them by now. Another set 
of features won’t rather by used by QGIS 

novices. 
This toolbar offers 12 
functions, which are: 
1 – Identify features – 

the quickest way of 
getting some 
information about the 
layer items, objects, 

etc. 
2 – Actions – used only when some actions are assigned to our layer. It’s for advanced users of QGIS. 
3 – Selecting features – four options included while select by polygon, select by freehand or radius. To be 
discussed later  
4 – Select features by value – again, another four options available, which are going to be discussed later 
(select features by expression, select features by value, select all features, invert selection). 

Pic. 26 An example of spatial bookmark. 

Pic. 27 The location of spatial bookmarks. 

Pic. 28 Attributes Toolbar with all options 
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5 – Deselect features from all layers – wipes out any selection applied across the project. 

6 – Open Attribute Table – the quickest way to get to our data content in QGIS 
7 – Open Field Calculator – another option rather for advanced users, which allows us to provide some 
changes in data attribute table by using specific formulae. 

8 – Toolbox – opens the Processing Toolbox as the panel (usually) on the right. Another function for 
advanced QGIS users. 
9 – Show statistical summary – quite useful option, especially for summarizing some distances, total 
number of items within our layer. By clicking this icon, user has the Statistic panel available (usually) on 

the left. The image above shows the statistical summary in action. It’s our interest to select the proper 
value (II), which statistics are needed. We can also use some expression for it (III) but probably not at the 
novice stage. If we want to get the statistical data just for selected features remember to thick the box in 
the bottom left corner (IV). The statistics are basic like shown in the image above (Pic. 29). 

Pic. 29 QGIS Statistical summary in action. 
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10 – Measure line/area/angle – such a fantastic set of three features, which allow user making detailed 
measurements in QGIS. In fact, it’s just manual way, which can be quickly replaced by appropriate 
formulae in data attribute table for all layers at once, but I doubt it’s an exercise for newbies. Therefore, 

this method can be used. Remember, that measurement results are based on the CRS system! If your 

layer CRS it’s not compatible with your project CRS (see Chapter 6) you will receive a rubbish.  

When doing measurement, the “Measure” or “Angle” window will always appear. For two-desktop 
workers it might be located far away from the QGIS window, but you can drag it closer when necessary. 

Important is, that the measurement tool cannot be switched off by clicking on it again. If you want 

to get rid of it, you must select the “Pan map” option from the Map Navigation Toolbar (Pic. 24). 

11 – Show map tips – the option requires some HTML & CSS skills for customizing and styling the box we 
want to display. We can use these boxes for showing some links to objects, etc. 

12 – Text annotation – a good way to show some comments, information in the specific place on our 
map. Apart from text 
annotation, we can also 
use form annotations, 
html annotations, SVG 
annotations and others. 
Some features might not 
work correctly, so the 
Annotation Manager 
plugin installation is 
necessary 
 

D. Digitizing 
Toolbar  

It’s not necessarily 
toolbar just for QGIS 
viewers, although it’s 
good to know some 
options from it.  

Pic. 30 Measuring area (left) and angle (right) in QGIS. 

Pic. 31 Text annotation in QGIS. 
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The digitizing toolbar 
includes options as follows: 
1 – Current edits – useful 
section, where user can do 
the saving for all & selected 

layers at once, make a rollback for all & selected layers if something went wrong and cancel for 
all & selected layers (Pic. 33).  
2 – Toggle editing – the most important feature of 
Digitizing Toolbar, where every user can start making 
some changes when necessary. It includes both 
playing with the attribute table, creating new objects 
in the attribute layer, and editing them. 
3 – Save layer edits. When inactive it means, that 
nothing has changed since we started editing. This is 
important step, which must be done for all layers 
before we close the QGIS down. In the situation, 
when our software is running slow, tends to freeze or 
even crashes, clicking on this option must be 
somewhat a knee-jerk task. 
4 - Add feature – depending on the geometry of our layer we will see here Add 
Point/Line/Polygon features. They are marked by specific signatures. The point layer is given in 
the example considered (Pic. 32). 
5 - Vertex tool – in order to make some slight changes in our layer we can move the vertices, add 
them or remove. The Vertex tool can work either for just our current layer or for all layers at once. 

6. Modify the attributes of all selected features 
simultaneously – this is something, which can be used 
instead of the field calculator. Since there some 
formula is required here even novice can handle with 
some changes, which apply for the whole lot. Rather 
than making some changes in attribute table, we can 
simply provide the given value (the same in fact) for all 
currently selected features or even for a whole column 

when everything in our layer is selected (Pic. 35). We have 3 types of symbology there appearing 
on the right. The green boxes in the row mean, that all the inputs across the whole column have 

Pic. 32 Digitizing toolbar in QGIS. 

Pic. 33 QGIS – current edits 

Pic. 34 Vertex tool – an example of moving one vertex. 

Pic.35 Modifying some attributes for selected layers at once and 
confirmation with data attribute table. 
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the same value. Yellow signature with circle, box and lozenge informs us, that some of values are 
different. The last one – red highlights, that changes haven’t been saved (applied) so far. 
7 – Delete selected – when the item is not needed anymore, we can delete it. In practise usually 
the quickest option is hit the Del button instead. 
8 – Cut features - Selected features are cut to clipboard 

9 – Copy features – Selected features are copied to clipboard 

10 – Paste features – Selected previously features are pasted where we want. 
11 – Undo 
12 – Redo 
 

E. Layer management toolbar 

                                                                                                                                                                                   

 

 

 

Layer management toolbar includes 12 options of adding new layer. The same options are 
available in the main panel in the “Layer” section as well as Data Source Manager (Pic. 37). 

 

          

         

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pic. 36 Layer management toolbar in QGIS. 

Pic. 37 Adding new layer by Data Source Manager in QGIS. 
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     However, there are some options missing. Maybe adding PostgreSQL is not an issue for QGIS 
newbies, but the Geopackage for sure! There is another option, which would allow us to add any kind of 
layer apart from options listed in these 2 cases. It’s just a simple drag & drop the file from the folder to QGIS 
(Pic. 38). 

 

Drag & drop is easy thing. However, we must remember some issues here. First of all, the layer can be added 
when you can see the “+Copy” above your QGIS map (I). Secondly, the tool will ask you about loading the 
components of the file (layer) we want to add. When dealing with Geopackage file we have usually several 
or even more layer within. It’s highly likely, that we will see the window like above (II) tough. Moreover, we 
need to select some of them or all of them by using “Select All” button (III). Optionally they can be grouped 
(III), which is helpful especially in the case when we already have other layers in our panel. 

F. Status Bar 

Status bar in QGIS is located at the bottom of the interface. Sometimes called information bar includes a few 
boxes in which you can find out information about the projection and navigation of the map. This bar also 
stores icons about any log messages (potential errors) and plugins awaiting updating. 

Our status bar has basically 8 options: 
1 – Search function – you can go quickly to processing tools or layers. It works analogically to the processing 
toolbox, although apart from just processing algorithms you can find the layers currently loaded to the 
project. 

 

Pic. 38 Adding new layer to QGIS by drag & drop the file from the folder. This is the quickest way of how we can load geopackage (.gpkg) 
file in QGIS.  

Pic. 39 Status bar options in QGIS.  
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2 – Coordinate box – informs us what are the coordinates of our current cursor 
location. They are CRS-based, so remember this. Instead of mouse position 
(signature on the right) we can toggle the coordinates of current map extends. 

3 – Scale – the most important thing here is, that the scale value changes x2 
when zoom in/out. If, for example your scale map is 1:2200, after scrolling your 

mouse or using the Zoom in option (Chapter 9.B.3) you will have the view at 

scale 1:1100. In the other side, when zoomed out, your scale will be 1:4400. 
Obviously, it’s not a fixed issue. You can always set up the scale you want by 
using the smallish dropdown on the right or just typing your own value in the 
box. Very important is the padlock on the right-hand side, which allows you to 
freeze the scale and prevent it from changes when zoom in/out. 

When our scale is frozen, 
the only way of how we can 

zoom in/out is the Magnifier.  

4 – Magnifier - Its role is different, because unlike the 
scale which brings us detail, the magnifier does just visual 
enlargement or diminution of the view. As you can spot 
in the image on the left, the view at scale of 1:569 has 

Pic. 40 Search function in use (next page).  

Pic. 41 Scale bar in use.  

Pic. 42 The role of magnifier in 
QGIS. 
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been just reduced from 100% to 25% and finally it’s the same view, just smaller than initially. Another tricky 
thing is the relation between Magnifier and Scale. Once the 25% is still in use, even when scale is unlocked, 

the view of the map will be 
reduced accordingly (Pic. 42). 

5 – Rotation – by setting an 
angle you can make your map 
rotated. As a result, just labels 
keep the “normal” view. 
Everything apart of it is a 
subject for rotation (layers + 
map canvas). 

6 – Render – very useful 
option for users, who work on 
large projects requiring long 
loading when zooming in/out. 
The primary downside of this 
option is a lack of precision 
when we want to edit 
vertices, add new object, etc. 
By switching “Render” off, 
QGIS is not able to recognize 
the proper place where we 
want to make some changes, 
albeit for viewers only it can 
be a minor issue. 

7 – Project CRS – information about current CRS and the shortcut for our project CRS settings at once. 

8 – Log Messages – the pop-up window including all information & errors since we started working on our 
project. As shown below, they are gathered in some sections. 

 

G. Browser panel 

The Browser panel acts like the folder tree in our QGIS. We have the quick access to bookmarks, recently 
saved layers and other QGIS projects. So, far only adding the new map canvas by using XYZ tiles was discussed 

(Chapter 6). 

The Browser panel act as the directory, which can be compared to some dialog window opened by Windows 
when we want to load files with some specific extension. It does look pretty much the same here. The 
directory is presented as a nice folder tree with all files considered as potential vector/raster or other types 
of layers for our QGIS project. It’s also the place from which we can drag & drop in the QGIS. Moreover, you 
can open the folder directly from here. 

 

Pic. 43 Relation between the scale and magnifier in QGIS. 

Pic. 44 Log Messages in QGIS, which are categorized. 
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The Browser panel handles a few options listed in the image, 
which can act as a nice shortcut for newbies. 

1 – Add selected layers – when the file extension is 
compatible with the layer type, then it can be added to QGIS 
straight from this panel. As told before, the same can be done 
by dragging & dropping the file into the main map canvas. 

2 – Refresh – simply updates the view of our directory 

3 – Filter browser – a nice option, which works likewise the 
search tool in Windows. We can find our file quickly by its 
name or extension. Our folder tree must be expanded 
correctly here (Pic. 46). 

4 – Collapse All – it closes all folders and basically retrieves 
the default view of the folder tree. 

5 – Enable/disable properties widget – the way for insight 
into the details of our file. We can get the information such 
as the geometry type, coordinates extent, number of features 
or units. 

Pic. 45 The Browser panel in QGIS 

Pic. 46 Finding some files in QGIS browser panel. 
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10. Working with layers panel 
The Layers panel is the most important for 
any user because it gives us an instant 
access to any layer included in our QGIS 
project. The Layers panel is the place where 
a user can see all the layers used in the 
project, count total amount their items 
straight away or access the data instantly. 

Apart from the clear list of layers we have additional options, which allows us to manage with all layers 
smoothly. 

1 – Open the layer styling panel – it opens a new panel, usually above the Layers panel. In this panel you 
can look at styling used for the given layer (to be selected by dropdown) and make some changes, when 
necessary, at the same basis as styling is defined in QGIS. Some bits of this matter will be discussed later in 
this tutorial. 

2 – Add Group – the handy option, which allows you to congregate some layers as per various 
topics/usage, etc.  

 

3 – Layer visibility dropdown – includes several additional options, which help us to manage with layer 
visibility. The options listed below are mostly show/hide everything in one go, which is very handy. Another 

thing is the map theme, which can be 
customized and saved.  This is a nice 
shortcut mostly for printing our map. First – 
map theme is otherworldly the group of 
layers saved as the map. So, if you have 
grouped your layers earlier, now you can 
see them as the map theme. The “Replace 
Theme” option can be used for changing 
the current map with other one saved 
earlier.  

4 – Filter legend my map content – 
interesting option for “slimming down” 
your legend when zoom in. It will include 

Pic. 48 Creating layer group in QGIS. 

Pic. 49 Show/Hide layers options 

Pic. 47 Options in the QGIS Layers panel main bar. 
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just these layers or categorized items, which are visible in the current map zoom level. 

5 – Filter legend by expression – applies to one layer only. We can filter the legend categories by expression, 
although it doesn’t seem to be task for QGIS newbies. 

6 – Expand all – expands all the layers which have categorized items.  

7 – Collapse all – Collapses all the layers which have categorized items. 

8 – Remove layer group – removes layer group with all layers inside. Make sure, that you are doing this step 
wisely and you thought over everything before! You can still add these layers again to QGIS, but it will be 
wasting of time. 

9 – Manage default tree properties – can be useful when you are unhappy with default font and icons. 

The Layer panel features many 
other options available for any 
layer by right-clicking (Pic. 52).  

- Zoom to Layer – zooms user 
directly to the layer. It works 
especially for layers restricted to 
some small area. Zoom level is 
adjusted to it. If our layer covers 
i.e., the whole town, there is no 
need to use this feature. 
- Zoom to Selection – needed 
especially when we have some 
bits selected and we don’t know 

Pic. 52 (bottom-right) Show/Hide layers options 

Pic. 51 (bottom-left) Right-clicking list of options offered by the Layers panel for each layer. 

Pic. 50 (top) Layer in Overview panel. 
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where they are. It works at the same basis as the previous one. It’s a very handy feature. 
- Show in Overview – the option useful just for another – 

the Overview panel, which should be toggled separately. 
As long as the binoculars icon remains active, we can see 
the layer active in the Overview panel. The zoom level in 
Overview panel is also subject of changes depending on 
the size of our layer or area covered by all the layers 
which have been toggled as shown in Overview (Pic. 50).  

- Show feature count – very useful option, which 
calculates instantly all the items belonging to the 
particular layer even when categorized (Pic. 51)  

- Copy Layer – the 
same option as 
presented earlier 

(Chapter 9, D, 
Pic. 32). We can 

copy our layer. 
- Rename Layer – an 

option for changing 
the name of our 
layer 

- Duplicate layer – it 
replicates our layer 
exactly in the place 
and shape as it 
was. It’s very useful 
for some reason, 
when we want to 
cope with more 
labelling criteria or 
simply show our layer as doubled. When your layer is heavy, give your computer a while for rendering 
it. 

- Remove layer – removes layer from our QGIS project making it lighter and faster at once. It doesn’t 
remove group, just layer thereby loading it again into QGIS won’t be a big issue. 

- Move to Top – very handy shortcut in the situation when our layer falls somewhere in the bottom 
and it’s not visible properly (or even hidden at all by i.e., the map tiles). By clicking this option, we 
are emphasizing the visibility of the given layer, because it’s placed at the very beginning of the Layers 
list and not hidden anymore. In the other hand this layer overlaps all others lying underneath it. 

- Move out of the group – the option visible just for grouped layers. When user doesn’t want to have 
this layer assigned to the group, he can simply move it out. Both Move to the Top as well as Move 
Out of the Group work in manual way by dragging and dropping, but when our project is large it 
might take a while to, therefore far better is using these shortcuts provided. 

- Open Attribute table – opens the details of our data, which will be discussed almost straight after 
this chapter. 

- Toggle editing – The same as discussed earlier (Chapter 9, D, Pic.32) we can make our layer 

editable. 
- Filter – not necessarily an attribute for QGIS novices. We can basically filter the visibility of our layer 

items by expression (query builder). 
- Change data source – it’s relevant in the case when our QGIS project have been moved somewhere 

or in the other hand some layers has changed their directory. As a result, QGIS cannot find them after 

Pic. 53 Categorized layer legend with the “Show 
features count” option applied. 

Pic. 54 The “Handle Unavailable Layers” window 
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loading the project. It’s often shown as the information window “Handle Unavailable Layers” (Pic. 
54) where we can find the new layer location on our own. In fact, QGIS can help us with it when the 
layer by Auto-Find option, but better is do it manually. The best option is saving our layer as relative 
path instead of absolute. 

-  Set Layer scale visibility – a nice shortcut, where we can define the range of scale in which our layer 
will be rendered. In practise it’s the zoom threshold above which the layer will become invisible. It 
works in the case when our project is congested and most of stuff tends to merge when zooming out. 

- Set CRS – another shortcut, which help us to get quickly to the coordinate system options for our 

layer. Discussed in the Chapter 6. 

- Export – a way of which we can export our layer 
to desired format. To be discussed later. 

- Styles – the option which allows us to copy the 
style of given layer or paste the style from 
another layer, which is similar. We can also add a 
new style here or change its name. All the styles 
made by us will appear on the Styles section after 
expanding (Pic. 55). 

- Properties – an instant access to layer properties, 
to be discussed later in this text. 
 

11. Interface – summary 
 

At the end of explaining how the QGIS main interface works it’s essential to raise information about 
remaining some bits, which can help us with the general navigation skills. 

The screenshot above (Pic. 56) shows elements, which knowledge is helpful in the day-to-day work 
with the program. They help us navigate a specific piece of the interface smoothly. 

Pic. 55 List of current styles available for our layer. 

Pic. 56 List of current styles available for our layer. 
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 I – the vertical row of dots – after hovering our cursor changes into cross      enabling us to move 

the panel in different place in our major toolbar (II). 

II – The section of main toolbar “prepared” for the toolbar “deposition” – it’s ready for 

dropping the toolbar we want there. 

III – the “>>” symbol - 

means, that the given toolbar 
hasn’t been expanded 
enough and some of options 
are simply hidden. The 
toolbar can be expanded by 
using the symbol I.  

IV – the upside-down 
triangle    - which states that 

the given option is 
expandable and includes at 
least 2-3 other ways of 
solution. 

 V – the horizontal row 
of dots “…….” - Plays an 

analogue role to symbol I. 
Here we can expand or 
reduce the dimensions of the 
given panel. It’s useful 
especially when we want to 
see all layers included in our 
project. 

VI – The symbols 

described in chapter 
3.A. - applying to the single 

panel. One of them shuts 
down the panel an adjacent 
one pops the panel out of the 
sidebar like described earlier. 
 

12. Checking 
layer properties 
 

This is the last option 
considered after the right-
click on the layer. In fact, it’s 

a bunch of many other 
options, in which we can 

make a lot of alterations to our layer. Some of them will be discussed here, although most of options don’t 
seem to be easy for QGIS newbies. 
Basically we can start from the very beginning of the list (Pic. 57) and briefly discuss all of them: 

Pic. 57 The list of layer properties in QGIS with Information panel displayed. 
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- Information – the whole panel you can see above (Pic. 57), which includes a few sections informing 
us about the layer origination and its content. It’s worth to look at the following things: 
-> Path – inform us about the location of our layer. 
-> CRS – current coordinate system of our layer. 
-> Storage – in other words the file extension in which our layer is stored. 
-> Geometry – what type of geometry has our layer. 
-> Feature count – total number of features included in our layer. 
Other information is listed in the image above. 

- Source – it basically refers to the coordinate reference system. There is an option for feature filter 
there, but it’s the advance feature. 

- Symbology – the place where we can style our layer. It will be discussed later. 
- Labels – providing text labels to our features. It will be also discussed later. 
- Masks – the option for stroke outlines around the layer items. It works at the same basis as the 

masks around labels discussed later. 
- Diagrams – very nice option for users, who must prepare the proportional symbol maps. The 

creation is based on the expressions, therefore might be difficult for newbies. 
- 3D View – nice option for 3-dimensional visualizing of our layer, although recommended rather for 

gaming computers with a good graphic card. 
- Fields – an insight on the data attribute columns, where we can find especially their type (Boolean, 

string, double, etc). If some fields have been joined from other layer, they are also visible here. 
- Attributes form – the detailed options for any attribute column and the way of how we can input 

the data. We can automatize some inputs here.  
- Joins – the tool joining the correspondent attribute tables from another layer 

- Auxiliary Storage – visible only when labels have been rotated from the label panel. They include 
information where the certain rotation circumstances are stored. 

- Actions – the list of actions assigned to our layer. 
- Display – here is the place for creating the map tip by using basic HTML code. The map tip will be 

displayed when clicking anywhere on our map. 
-  Rendering – for newbies the most important can be the “Scale dependant visibility” discussed 

earlier (Chapter 11) which defines the layer scale visibility range. 

- Variables – the list of all variables available at the layer’s level. It’s just mostly for information 
purpose. 

Pic. 58 The legend properties for one of the layers in QGIS project. 
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- Metadata – the section, where we can provide additional information about our layer like 
copyright, etc.  

- Dependencies – this tab allows you to declare data dependencies between layers. It means, that we 
can select the layer, which may alter externally the data in other layer and other way around. This is 
rather for advanced QGIS users. 

- Legend properties – the box, in which user can adjust the visibility of our layer by adding some 
description on your symbol (flexible font and size) or set the degree of layer opacity as shown above. 

- QGIS Server – it’s option rather for advanced users. You can provide your own WMS connection based 
on the file you are using as the layer. 

- Digitizing – here we can ensure about the validity of our layer. The option allows us to check the 
quality of digitized properties. 
 

13. Selecting layers & items 
 

Layer section is important thing in QGIS, because we can distinguish the items from the layer. The selection 
also allows us to extract the piece of data, about which it will be explained later. The selection options are 

in the attribute toolbar (Chapter 9 B, Pic. 28). We have several options of the selection (Pic. 59). 

- Select Feature(s) – we are selecting any feature by clicking. We can select them more by holding the 
Ctrl button. Another way is holding mouse and dragging the cursor, which eventually makes the 
selection box. Everything within as well as crossing this box is to be selected. 

- Select Features by Polygon – an analogous option to the previous one, but instead of the box, we can 
select our items by polygon (Pic. 60). Likewise, previously, everything falling inside or crossing the 
polygon will be selected.  

Pic. 59 Selecting options in QGIS. 

Pic. 60 Selecting features by polygon in QGIS. Selection polygon on the left and selected features on the right. 
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- Select features by freehand – similar to the two previous options. It’s enough just to click somewhere 
in the map and as you move your cursor, the freehand polygon is created automatically. 

- Select Features by Radius – as you set your cursor somewhere on the map and see the purple cross 
(X) now you can click and see how your circular selection increases (Pic. 61). On the right there is an 
information about the radius value, which is displayed in meters (despite lack of unit provided). You 
can set it manually either. If you are unsure the measurement unit, there is a plugin Select by Radius 
Plus, which will take care of it for you. 

- Select features by value – this is a cool option of selection, which can be based on value or more than 
one values. We’ve got here all the attribute table inputs, which can be used.  Moreover, this option 
allows us to zoom to selected features or add something more to our current selection. 

- Select feature by expression – an analogous option to the previous one, but requires some knowledge 
about QGIS expressions, which aren’t covered in this text, dedicated just for viewers/newbies. 

- Select all features – selects everything which belongs to our current layer. 
- Invert feature selection – can be really handy when we just need two group of selections. This option 

simply reverts the selection of the items. If for instance, we have all the items selected with the given 
value like shown in the image above (Pic. 62). Invert selection will deselect them and select all 
remaining items in the current layer instead. 

- Deselect all – the rightmost option in the panel, which switches off the selection completely. Nothing 
is selected since then. Alternatively, you can use the Invert feature selection in the case when all the 
features in your layer are selected. The effect will be the same though. 

Pic. 61 Selecting features by radius in QGIS. 

Pic. 62 Invert feature selection in QGIS. 
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There are also other methods of the layer selection. Instead of using the “Select feature by value” we can 
switch off some legend categories from the Layer panel and use the “Select all features” in some cases (Pic. 
63). 

 

In the Layers panel, where we have the list of layers, each layer with more than 1 style applied (mostly rule-
based or categorized) has its own legend retrieved from the symbology. Each of categories can be switched 
on/off, although all the are visible in default. The image above shows the situation, where just one of 
categories is selected. Thereby just this category can be selected in the case like this. Imagine, that our 
categorized criteria have been based on the same value as shown in the earlier image (Pic. 63), the result of 
selection will be exactly the same! Bear in mind, that since the selection of all items has been applied, it will 
be assigned for another category too when switched on. Anyhow this is the case, where the specific 
selection, based on the style category can be done. 

Pic. 63 (Up) Selecting features by value. 

Pic. 64 (Down) Switching on/off categorized items from the layers panel. 
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More advanced selection method applies to choosing items, which falls inside the other layer. It’s not in fact 
the thing, which the QGIS newbies should be familiar with, although it’s good to know for the future 
reference, that the option such as this exists. We should use Vector -> Research Tools -> Select by location 
and define both the layer which items we want to select and the layer, which these items potentially overlap. 
Apart from the Select by location we can use the Random Selection and select just sample of the given layer 
like 10 items or so. Another – Random Selection within subsets does the same but with respect of the 
particular attribute table value provided. In general, both methods are just rather out of interests, because 
the selection such as this is mostly senseless. 

 

14. Inspecting items 
 

Another thing, which is like selection of the layer items is the inspection. The inspection seems to be far 
more beneficial than selection because it provides all the details about our layer items. Unlike the normal 
selection, where you have just highlighted features by the other colour, inspection gives you the possibility 
of providing and changing data inputs in attribute table.  You cannot do it from the selection panel because 
you must visit the data attribute table. The Identify Results tool emerges as the separate panel, usually on 
the right sidebar.  The Identify results option is wealth with features, which are shown in the image below 
and described accordingly (Pic. 65). 

 

1 – View feature form – shown in the image above (Pic. 65). This is the section, where you can edit the values 
of feature attributes. Obviously, it’s available only when your layer is toggled in editing mode. Otherwise, 
you will see greyed inputs like above. 

2 – Expand Tree – expands all sections preceded by the symbol     , although it’s not necessary using it, 
because in default we have all information from attribute table, which we need. 

3 – Collapse Tree – it’s rather not recommended, because we will have everything hidden. 

Pic. 65 Identify Results in QGIS – available options (I), the interface (II), mode selection (III) and feature attributes. 
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4 – Expand New Results as Default – it determines whether the next identified feature’s information should 
be collapsed or expanded. It’s better to keep this option switched off as we don’t need the full sections 
(Derived, Actions) expanded all the time, just pure data from the attribute table. 

5 – Clear results – erase everything leaving an empty dialog window. 

6 – Copy selected features to 
clipboard – copies whole identify 
content to clipboard. 

7 – Print selected HTML Response – 
this option is for advance QGIS 
users, remains mostly inactive in our 
cases. 

8 – Identify features by area or 
single click – we have the same 
options as by the selection features. 
We can do the identification by 
single click/box, polygon, freehand 
or radius. The image next to shows 

an example of identification of multiple features by polygon. Worth attention is the Feature panel, which 
now includes all types of layers and items selected. Each single item comes as “fid” and its expandable at the 
same manner as the single one. 

9 – Identify Settings – it’s just one option there - Auto-open form for single feature results, which opens 
instantly the Feature Attributes form when clicked on just one single feature of our layer. Can be useful in 
the case when user wants to edit something quickly. The Feature attribute is launched on account of Identify 
Panel which is not. 

Next area of concern is the feature panel (Pic. 65, II), where all relevant information is shown. Basically the 
“Derived” and “Actions” section is not needed to know. We just need to know all the inputs from “fid” to the 
bottom, which correspond to our data attribute table (being more precise to Feature Attributes section). 

Mode (Selection Mode) (Pic. 65, III) – it’s important because it defines of how we can select the layer. Usually, 
we have more than 1 layer in the place of clicking. The following options here are defining the way of how 
the items must be selected: 
       - Current layer – it works just for active (not necessarily editable) layer in QGIS (Pic. 67). 

Pic. 66 Identifying features by polygon. 

Pic. 67 Identifying features of current layer in QGIS. 
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- Top down, stop at first – user can select all layers regardless their position, although only one layer 
can be selected at the given time. 

- Top down – all the layers are selected from the bottom to the top when clicking at the certain location 
(Pic. 68). 

- Layer selection – the panel gives you an opportunity to choose which layer do you want to inspect 
when clicking at some location. Personally, I would recommend this option as the best (Pic. 69). The 
same effect you can have regardless of the mode when you right-click on your selected location. 

Pic. 69 Identifying features by “Top down” mode in QGIS. All the layers are selected when clicking at certain location. 

Pic. 68 Identifying features by “Layer selection” mode in QGIS. You have the choice of the following layers available at the location 
where you clicked. 
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There is also another set of options for Identify Results in QGIS 
available after right-click. Some of them repeats, but some of them 
are completely new (Pic. 69). Following the list of options, we have: 
-> Edit Feature Form… - as discussed above, user can provide some 
new inputs into the attribute table via this form. 
-> Zoom to feature – QGIS takes us directly to the place where this 
selected feature (or group of features) is located.  
-> Copy Feature – option for copying an item, the same as discussed 

earlier (Chapter 9, D, 9). 
-> Toggle Feature Selection – selects the current feature under 

investigation. 
-> Copy Attribute Value – the same option like in the main panel, 
simply another way of how we can copy the attribute value to the 

clipboard 
-> Clear Results – erases everything 
leaving blank panel 
-> Clear Highlights – deselects the features 
selected just for identification. If we used 
the “Toggle Feature Selection” the typical 
selection remains in place. 
-> Highlight All – works just in the case 
when we selected more than 1 element 
for inspection. Obviously, we can read just 
one per time, therefore just this one will 
be highlighted within area of our selection. 
By choosing the “Highlight All” option we 
can see all of them active again within the 
area of our selection (Pic. 71).  
-> Highlight Layer – it works similarly to the previous option, although instead of all elements in the 
selected area, just the items of one layer are highlighted. 
-> Activate Layer – this option activates and toggles editing mode for the layer concerned. 

-> Layer Properties – opens pop-up window with all layer properties as discussed in the chapter 14. 

-> Expand All – the same as discussed in the main panel 
-> Collapse All – as per discussed above 

 

 

 

 

 

 

 

 

 

 

 

Pic. 70 Identifying features in QGIS – 
mouse right-click options. 

Pic. 71 Using “Highlight All” option in the QGIS Identify Results panel. 



38 
 

15. Important settings 
 

Some tools described here so far give the possibility of changes some settings, which are mostly 
concentrated in the following place: QGIS main bar -> Settings -> Options. 
In the QGIS novice’s point of view important are especially Map Tools (QGIS main bar -> Settings -> Options 
-> Map Tools). 

We have the following options here: 

I – Identify – options for changing the behaviour of Identify Results. 

-> Search radius identifying features ad displaying map tips – as default set to 2mm, which means that we 
must click almost always on the layer. However, if you change it to 20mm instead for example, then the 
buffer between clicking on the map and highlighted layer for identifying will be much thicker. 
-> Highlight colour – can be changed, as default comes semi-transparent red. Everything is changeable here 
along with the Buffer thickness and its minimum width. 

II – Measure Tool – as you can see above (Pic. 72) the subject of changes are colour, decimal places, and 

preferred units. Nothing to explain here really. 

III – Coordinate and Bearing Display – defines the way of displaying the mouse coordinates in the 

status bar when panning the map canvas. It works just for WGS 84. 

IV – Zooming – as default set as 200%, which can be changed. The 2x zoom level have been already 

discussed in chapter 10, Pic. 39, 4.  

Pic. 72 The “Map tools” settings in QGIS. 
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V – Predefined scales – good option, when working on non-standard maps, to which the common scales 

like 1:10000, 1:5000 don’t fit. We can set up our own scale, on which your map will be operated. 

Other options aren’t important that much for QGIS newbies. Below are some issues, which it’s good to 
know even at the getting started stage with QGIS: 

QGIS main panel -> Settings -> Options -> Digitizing (Pic. 73). 

Pic. 73 The “Digitizing tools” settings in QGIS. 

Pic. 74 The “Rubberband” customization in QGIS. 
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There are other options useful for 
newbies: 

I – Feature creation – everything, 

which is set as default should remain 
in place. 

II – Rubberband – the options for 

new layer creations. You have the 
right to change the line width, line 
colour and fill colour (Pic. 74), which 
basically can be beneficial in the case 
when you are struggling to see the 
new layer draft in your QGIS project 
because of i.e., map canvas 

coloration.  

III – Snapping – very handy tool. 

You must make sure, that “Enabling 
snapping by default” is turned on. 

Moreover, you can change the colour of your snapping marker, which appears pink as default. Important is 
also the snapping tolerance, which defines the “distance” at which the tool starts to snap your vertex to the 
nearest existing point or line. As default it’s reasonable 10 pixels, but it’s subject to change by user. Other 
options are not necessary for use when you start your adventure with QGIS. 

IV – Vertex markers – they appear just for selected features (at least as default option) and personally I 

would leave it as it is. Marker style is set as Cross, whereas you can choose also semi-transparent circle, 
whatever works better for you. Marker size is also subject of changes (Pic. 75). 
The last option Curve Offset Tool should also remain as it is. 

Project -> Properties -> General -> General settings – we have some important bits here, which might 
require attention from the very first day our work with QGIS (Pic. 76). 

I General settings – the most important for the QGIS novice’s point of view because we have the project 

file path here as well as Saving path or selection & background colour (Pic. 73). Since the background colour 
is not important that much, the 
selection colour of course! 
Especially, when both colours 
are exportable along with the 
map to image, which will be 
discussed later. 

 

Pic. 75 The Vertex markers with size of 10px instead of 3px set as default. 

Pic. 76 The selection and background colour settings in the QGIS Project properties.  
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II Measurements – should remain as default. However, the most intriguing option here is “Ellipsoid (for 

distance and area calculations)”, which is set to EPSG:7001 as default. Remember, that measurements 
based on this ellipsoid are doable just for not projected layers. If you already set the CRS for your layer, all 
the measurements will be based on your CRS system defined. All the option should rather remain the same. 

III – Coordinate and Bearing Display – everything should remain as default here. 

IV – Project Predefined Scales – as discussed above, here is also the place, where we can predefine the 

non-standard map scale for our project. 
The last option once we move our slider down is “Generate Project Translation File”, which won’t be useful 
for users working in English environment. 

 

16. Working with data attribute table 
 

Data attribute table is a pivot thing in QGIS. This is the core element of each layer, which stores all the 
database. Every user must remember that layer its’ not just the geometry visible on the map. Layer is also a 
database on which most of our QGIS operations are based. We can use the various styling, labelling, 
selections, which are based on the attribute data. Each formulation requires some data to stick to, therefore 
having something apart just from the geometry is a mandatory! The new user to QGIS should know how to 
play with the random attribute data, how to make the correct selection, how to read the number of values 

Pic. 77 Important settings in Project Properties -> General section 
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and how to extract this data outside.  The image below shows the visual components of data attribute table 
window, which should be clearly understandable for anyone who started learning QGIS recently.  

I – Total features count – another way of counting how many items is included in our layer. It’s not as 

quick method as described earlier (Chapter 10, Pic. 53), but better for use when some random features 

are selected. Every time when our attribute 
table dock is opened in the top left corner, 
we can see how many features we have in 
total, how many of them have been filtered 
(Pic. 79). Admittedly, this way can be 
achieved also when using categorized or 

rule-based styling and next displaying the “Show feature count” in the layer category as shown above 

(Chapter 10, Pic. 53), although in other situation this approach will be beneficial. Another value 

corresponds to the selected items. When you select any items within the given layer both in your QGIS map 
or in the attribute table, then the number of selected features will appear in the top-left attribute table dock 
calculation. 

II – Data attribute table toolbar – a bunch of useful options, which will be discussed later here. 

III – Formula bar – analogue input to Microsoft Excel where you can provide the formula (expression) and 

execute it in data attribute table (the layer you are working on). At the end of this bar, you have two options. 
By clicking the first one, the provided expression will update everything in our layer regardless the selection 
or filtering applied. The second option will update just selected records. 

IV – Data attribute table – the most important content of the whole dock, where we have all information 

about every single item included in our layer. Depending on the amount of data we can have this content 

Pic. 78 The components of data attribute table. 

Pic. 79 Filtering data in attribute table dock. 
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wealth or poor. If you have more than shown in the image above (Pic. 78), you should see the horizontal 
slider at the bottom of this table. 

V – Display options – as default we have the “Show All Features” toggled a user can see everything, what 

belongs to the given layer. In fact, it’s not the only option here and I believe there is something more, which 
the QGIS newcomer can play with (Pic. 76). 

Other options are listed in the image on the 
left (Pic. 79).  
-> Show Selected Features – displays only the 
stuff, which has been selected both on map 
and in the attribute table. Remember, that 
everything which has been selected on the 
map will be selected in data attribute table as 
well. It works the same way for an opposite 
direction and vice versa! 
-> Show Features Visible on Map – cool option, 
which displays only the stuff visible on the map 
at current zoom level. It works analogically to 
the Box selection, where even a piece of item 
falling inside is enough to be selected. 
-> Show Edited and New Features – displays 

only the features, which have been changed 
or added recently. It’s a good approach in 

the situation when we want to double check what has happened with the layer items during our work 
process. The option is valid just when the layer is editable. Its pivot role is making sure, that everything is 
alright before we switch off the editing mode and save changes! 
-> Field filter – classifying the features by certain field (column), although the accurate value is required here. 
-> Advanced Filter (Expression) – option for more advanced QGIS users. 
-> Stored Filter Expressions – in the case when we have applied some expressions recently, they will appear 
in this option, facilitating us using them in the future without typing them again. 
-> Current criterion – displays on which conditions we are making current selection. 

VI – Switching Mode – we can toggle between the form view and table view. In the form view we have 

slightly different layout, which includes a few more options to manage the layer features. 

Pic. 80 Filtering data in attribute table dock. 

Pic. 81 Data attribute table – the form view. 
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Basically, the form view features the similar layout to the identify (Chapter 14, Pic. 65), although it’s more 

wealth with other features. Unlike the feature attributes in the Identify Results panel we are looking at many 
more items. Therefore, we can toggle between them by using the left sidebar. At the bottom of this sidebar, 
you can find a few symbols, which correspond to the following: 
a – move to the very first item (very top of the list), 

b – move to the previous, 
c – move to the next, 
d – move to the last (very bottom of the table), 
e – order of the item (currently active 71st out of 75 included in the layer), 
 

f – highlight current feature on 
the map – by having it active 
we can take a look where the 
feature is located (selected on 
the map), 
g – automatically pan to 
current feature – when 
highlighted on the map, user 
might not know its certain 
location, therefore clicking this 
icon QGIS will place the map 
area where the feature is 

located, 
h – automatically zoom to the 
current feature – panning the 
map might be not enough, 
when the zoom level is 
inappropriate. Clicking this 
icon QGIS will both pan and 
zoom to the location of the 
item at once. 

Important is to understand of 
how the feature selection 
works in the form view. They 
are highlighted in yellow (Pic. 
82). 

 

The most important is the attribute toolbar, which is located at the top (Pic. 78, II, Pic. 83). 
 

 

 

 

1 – Toggle editing mode – the same as discussed earlier (Chapter 9 D Pic. 32, 2). Once toggled we have 

the attribute table content editable and most of other options active. It works at the same basis as in the 
case of layers. By toggling the editing mode off QGIS will ask us about saving the current changes.  

Pic. 83 Data attribute table – toolbar. 

Pic. 82 Data attribute table – visibility of selected features compared between 
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2 – Toggle multi-edit mode – works for many features. Basic workplace here is the form view instead of 
table view (Pic. 84). When something is selected, it appears as yellow box on the left, which corresponds to 
highlighted blue line in the table view as discussed above. 

As you can see, the symbology is the same as discussed previously (Chapter 9, D, Pic. 35). Green shapes 

mean, that the value provided is the same for all selected features. Yellow shapes forewarn us, that the 
values vary across the selected features. The red signatures state as alert, that some changes have been 
made and not saved. Users must bear it in mind before making some edits. Anyway, this option can be 
treated as a nice shortcut especially for new QGIS users, who aren’t familiar with the expressions. Indeed, 
the multi-edit mode can be somewhat replaced by using the appropriate expressions across the data 
attribute table, but not in the case when we are getting around with QGIS software. Not to mention, that by 
using this editing mode we can still provide some expressions for all selected features at once since the 
“formula bar” remains in the same place where it is in table view. 

3 – Save edits – the same function as discussed, several times before. When edits are saved this way, the 
switching off editing mode won’t run the pop-up save changes alert. 

4 – Reload the table – simple refreshing the attribute table content. 

5 – Add feature – completely new feature is added to our attribute table. Don’t expect it on the map because 
the geometry is not provided. By zooming to the feature, you should expect an error saying, that our “feature 

has no geometry” (Pic. 85). The problem such as 
this can be fixed by using the “Add Part” option 
in the Advanced Digitizing Toolbar. 

6 – Delete selected features – by clicking this 
option we are removing everything, which was selected previously. 

7 – Cut selected rows to clipboard – cuts selected rows to clipboard as the name of this option says. 
8 – Copy selected rows to clipboard 
9 – Paste features from clipboard 
10 – Select feature by expression – not for QGIS newbies. 
11 – Select All – selects all the items belonging to our layer. 

Pic. 84 Multi-edit mode in QGIS attribute table. 

Pic. 85 Error appearing after adding new feature directly in attribute 
table. 
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12 – Invert Selection – overturn the previous selection of features. 
13 – Deselect All – removes selection from the attribute table. 

14 – Select/Filter features using form – pretty much analogous approach to selection features by expression. 
In this case instead of expressions we have a nice alternative for someone, who is not savvy enough to. 
Thereby anyone, who starts using QGIS can play with it (Pic. 86). 

Each column has its own options to choose, which you can see above. As default “Exclude Field” is toggled, 
but we can provide our own value, which appears across the attributes and define the proper condition to 
it. Each condition can be the “Case sensitive”, which means that our records are differentiated between 
capital and lower-case letters. It’s worth to look at the other options beneath (Pic. 87). 

-> Reset form – clears all conditions applied. 
-> Flash Features – just brief blazing of the layer content, which has been filtered. 
-> Zoom to features – the same as discussed earlier, when clicked QGIS will redirect us to the given object 
or group of objects selected. 
-> Select Features – as you can see it’s not only one option there (Pic. 87), because we can add them to 
current existing selection, remove them from the existing selection or filter current selection. The last 
option it’s just reducing the number of selected features by adding an additional condition. We might as 
well use the “Select Features” instead. 
-> Filter Features -> by two options, within and outside. By using one of them the QGIS we are building an 
expression automatically and use it via Advanced Filter (Pic. 88). 

Pic. 86 Select/filter features using form in QGIS data attribute table. 

Pic. 87 Select/filter features using form in QGIS data attribute table – other options. 
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The most important thing is, that you can do nothing with it, just select one of these 2 options. The 
expression will appear automatically. 

15 – Move selection to the top – takes our records to the very beginning of our table. When switched on 
every other selected feature will be brought at the very beginning of our layer instantly. 
16 – Pan map to the selected rows – centres our map canvas to the selected layer items, which act as rows 
in data attribute table. 
17 – Zoom map to the selected rows – adjusts zoom level to selected features and pans it automatically as 
well. 
18 – New Field – not necessarily for QGIS newbies, but here we can append our data attribute table by 
creating a new column (field). The column for all the features will be empty (NULL) as default. 
19 – Delete field – when we are sure, that the given column is not needed anymore, we can delete it. 
20 – Organize columns – we can change their order. It’s just temporary thing, which doesn’t work all the 
time. After saving our layer to some formats the order might be forgotten, therefore better is refactor our 
attribute fields. 
21 – Open Field calculator – it’s an option for advanced users. Basically, we can shape our layer content by 
executing some formulas. 
22 – Conditional formatting – also option for more advanced QGIS users, because it requires using 
formulas. 
23 – Dock attribute table – a nice option allowing user to have both map canvas and attribute table in one 
working panel (Pic. 89). 

Pic. 88 Filtering features in attribute table with autocreation of expressions. 
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We can easily undock this attribute table dialog by clicking the double-box just next to the escape “cross” 
sign on the top right (the same as discussed in the Chapter 3A, Pic. 3). 
25 – Actions – again, something for advanced users, who can assign actions to the specific features in data 
attribute table. 

 

Import (adding) layer 

 

Often happens, that the set of layers is not enough for our project. In other situation you have just files, 
which must be displayed in QGIS in order i.e., printing the output map.  In this chapter you will learn how to 
add various types of layers to QGIS on different ways. 
One way is going to the main QGIS toolbar and select Layer -> Add Layer and choosing the relevant option 
(Pic. 90). 

Pic. 89 Filtering features in attribute table with autocreation of expressions. 
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User can add vector layer – it’s just selecting the proper file from your directory, which extension can be: 
.shp (Shapefile) .geojson, .kml (Keyhole Markup Language) .gml (Geography Markup Language) .dxf and  
others. Another intriguing option here is adding a whole directory instead of file. It won’t be useful that 
much, but I guess it’s good to know (Pic. 91). 

Pic. 90 Adding layers to QGIS. For novices just 3 types of layers can be under consideration.  
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Another type of layer, which surely can be added by anyone to QGIS is the raster layer. Unlike vector layer, 
which represents the spatial distribution of editable features, raster layer comes usually as the 
georeferenced image. This image can be the file with following extensions: .pdf (only raster version, because 
there is also vector .pdf versions), .png (previously georeferenced with separate .pgw file coming along with) 
and .geotiff (commonly used raster format in GIS environment). 

The trickiest type of layer to add by new QGIS user is the comma separated type of layer. The image above 
(Pic. 92) shows the Delimited text options and highlights the most important section to look at. Namely it’s 

Pic. 91 Adding whole directory to QGIS.  

Pic. 92 Adding comma delimited layer to QGIS with the most important section highlighted.  
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the Geometry Definition, which determines the placement of our features on the map. If we want to have 
our comma delimited values displayed on the map, our .csv file must be equipped with at least one column 
representing geometry. In the case like this we are talking about the Well-known text (WKT) geometry, which 
should be gained by previous export layer to the .csv format from QGIS or other GIS software. Since the .csv 
file is uploaded from external sources it must contain two columns with geometry as pointed out in the 
highlighted box above (Pic. 92). These are Point coordinates, which need to be defined in X and Y fields. It’s 
enough for making our point layer visible on the map. Our X corresponds to Latitude and Y to Longitude – 
this is an interpretation of cartesian coordinate system. The Z-field is the 3rd dimension of our layer and will 
be used for defining altitude when playing with 3D layers. The M-field states for measurement dimensions. 
When your .csv file contains just one column, you must use the “File format” -> Custom delimiters and select 
tab or comma or others in order to split your data between at least 2 columns. If we want to have our 
coordinates valid, we should define the geometry CRS properly, which initially comes as our project CRS. 
Another thing is Record and Field Options section right above. Amidst several options there, two of them 
are the most important. The first one is “First record and field names” and must be always included, when 
we are transferring the .csv file with column names. It will help QGIS to identify which columns are related 
to the coordinates. The “Detect field types” also cannot be ignored. QGIS can classify our comma separated 
data to appropriate type of fields (Integer, String, etc). 

Another way of adding the new layer to QGIS seems to be much quicker, because we don’t need to “visit” 
the aforementioned options dedicated for adding layer. In fact, the second way is the most beneficial for the 
.gpkg (Geopackage) files, which aren’t listed in the traditional “Add layer” section. The way of including 
these files in QGIS is very straightforward (Pic. 93), because we are dragging our file from the directory and 

dropping it to the QGIS map canvas. The same as discussed earlier (Chapter 8 E, Pic. 38). 

This method doesn’t work for comma-separated values because the determination of coordinates is 
necessary in this case. After drag & drop the .csv file to our QGIS we will have just pure attribute table without 
any geometry plotted on the map even when the file contains column with geometry. 

Pic. 93 Adding new layer (file) to QGIS by drag & drop. Needed mostly for the Geopackage file (.gpkg).  
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17. Styling layer 
 
Since you are a viewer, I guess you won’t deal with styling that much, especially when you load the 
Geopackage file. The Geopackage file includes both vector layers and their styling, which is very convenient 
for everyone. However sometimes we must load style separately to our layer. Before I get to this point it will 
be good to explain of how you can change the styling of the given object and how to transfer the styles 
between the similar layers within the current QGIS project. 

 

 A. Quick Style edit – this is myself-called option available after right-click on the layer. This is Right-

click -> Styles. Unfortunately, the option is somewhat misleading for users, because at first thing you could 
guess, that is the exact place for customizing your layer. Unfortunately, it’s not. It’s just a basic style 

adjustment available solely for single-styled 
layers (Pic. 94). The user can just play with 
coloration and basic symbology. If you are not 
planning to expand the          styling criteria, 
then it’s fine. If you wish to use more advanced 
styling, then this section won’t be good at all. 
This particular matter will be described later. 
Let’s have a look at other options available 
here.  

B. Transfer styling criteria 
between layers within the 
current QGIS project - So far just 

“Edit Symbol” has been discussed. This 
symbol can be copied and pasted to 

Pic. 94 Basic styling option in the Styles section after right-click on our layer.  

Pic. 95 The “Copy Style” options in QGIS.  
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another layer with the same geometry. This is surely 
the simplest and quickest style transfer between the 
layers, assuming that their geometry is the same. 
Since our styling is more advanced than discussed 
earlier, we should use the very top option, which is 
“Copy Style” (Pic. 95). Obviously, the quickest option 
here is copying “All style categories”, which basically 
include not only the styling but also some attribute 
table settings, potential expressions saved in the 
various properties (as seen in the list above). 
However, if we need just particular setting from this 
layer to be transferred, we can just select one of them. 
Next just this particular option will be available for 
pasting in another layer concerned (Pic. 96). It’s still 
applicable for layers with the same geometry. 
 

C. Transferring styling criteria between 
external files (or QGIS projects) – another 

way of getting ready styling features for layer we are working on, although it requires a bit more hassle. 
Again, we have two ways of doing it, where one of them is slower and another one faster. Let’s consider 
the “slower” one.  

 

Right-click on the layer -> Properties -> Symbology is the proper place for styling the same as Right-click 
on the layer -> Properties -> Labels (to be discussed later), next for masks and so forth as shown in the 
image above (Pic. 97). The common denominator of all these sections is the small “Style” button located 
in the bottom left. This is a dropdown including some options, from which we are picking up the very 
first one – “Load Style”. Once we select the “Load Style” we can load the external file from the directory. 
This file was surely saved previously by using the next option in the dropdown “Save Style” (Pic. 98) 
Other option for saving our style file is right-clock on our layer ->Properties -> Export -> Save as QGIS 
Layer Style file (only .qml extension). By saving our style to the separate file we can access it from any 
other QGIS project. However, this access must be done by proper loading this file. The way of how we 
can do it is also shown in the image above (Pic. 97). By using the “File” section at the bottom, we can 

click the “…” button which will pop-up the local directory for us. It’s always the recently used path. Now, 

we can select the QGIS style sile (.qml) and use it in our layer. At this moment it’s good to stress, that 
there are 2 types of QGIS style files, which we can save. The firs one (.qml) represents fully the symbology, 
and can be used with preserving all the renderers provided like rule-based styling, categorized styling, 

Pic. 96 The “Paste Style” options in QGIS.  

Pic. 97 Loading style from external file in QGIS.  
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etc. Therefore, in my point of view is better to use this style. The second one (.sld) doesn’t include the 
whole Symbology content, because this type of file converts the categorized and graduated styles to rule-based. 
The difference between these 2 styles is serious and can be seen in this example: 
https://gis.stackexchange.com/questions/254480/qml-style-differs-from-the-same-sld-style-saved-in-qgis 

On the left the second option “Save Style” is presented. You 
have just 2 options of saving your style file, which was 
discussed earlier. Important is another table listing all style 
sections applicable to the layer. The ticked ones are 
currently available for saving. Of course, you can select more 
of them or disable the existing ones. Anyhow everything 
selected will be included in your styling file and applicable 
for other layer in completely different QGIS project as long 
as the layer matches the geometry. This way saves all the 
styling detail starting from the colouration or symbology and 
finishing on labelling and some advanced expressions 
applied. In the other hand, the expressions will be valid just 
only in the case when the attribute table content matches 
properly the formulae applied. If not, the user won’t be able 
to execute the styling formula from imported file. As you 
apply more styling criteria, the further usage might be more 
restricted. Obviously, it’s still a quick way of applying the 
style because user can always alter some bits later. The 
saved style can be next imported by using more elegant 

method, which appears to 
be also the quickest. We 

need to use the Toolbox, 
which usually is located on the 
right sidebar. In the search bar 
at the top, just beneath the 
toolbar we can define what we 
want. Even if we start typing 
something, the list of tools 
start adjusting to our query. 
Type then until you see the 
“Set layer style” option (Pic. 
99) and double-click on it. This 
rule works for each other tool 
available in this box. 
The “Set layer style” is nothing 
else like attaching the external 
style file discussed earlier in 
this chapter. 

D. Advanced styling of 
the layer features - it’s 

possible by using the Symbology 
and Labels sections. It’s fair 
enough for someone, who begins 
its adventure with QGIS. Also, not 

Pic. 98 Saving style to the file in QGIS.  

Pic. 99 Loading style file via “Set layer style” option.  

https://gis.stackexchange.com/questions/254480/qml-style-differs-from-the-same-sld-style-saved-in-qgis
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all ways of styling will be discussed here. I think at this stage it’s enough to know about the following ways 

of styling features: 
-> No symbols – simply erases any styling applied for the layer making its invisible.  
-> Single symbol – as discussed earlier, a whole layer has the same colour and symbol applied regardless 
various parameters (feature values)  

-> Categorized – the certain value acts like 
category. By choosing this type of styling we must 
select the attribute table value and next click the 
“Classify” button underneath (Pic. 100). This way 
of styling is still simple. We can change the colours 
by using some predefined gradients instead of 
“Random colors”. The Legend input also can be 
changed by double-click and providing your own 

name when cursor is visible. Since the colour ramp 
selection is not always necessary, the change 
names of categories in our legend of course it is! 
Furthermore the Legend section strictly 
correspond to what we can see in the layer panel. 
-> Graduated – the most advance styling method 
to be discussed – we have a wide choice of colour 
ramps, although for the entry level important is to 
operate between four highlighted below (Pic. 
103). 
a – Legend format & Precision – legend format 
should remain in place, because it determines the 
range from the lowest (%1) to the highest (%2) 
value in the given section. Precision regulates the 
number of decimals. Full number in legend means 
Precision set to 0. However, we can always play 
with it (Pic. 102). 

Pic. 100 Categorized layer style in QGIS.  

Pic. 101 Change name of Legend in categorized styling in QGIS. 

Pic. 102 Changing legend precision in graduated styling. 
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b – Method – we can choose between the colour and size. Above you can see the colour ramp applied. It’s 

Pic. 103 Graduated layer style in QGIS with pivot options highlighted.  

Pic. 104 Colour ramp settings.  



57 
 

just a simple colour ramp comprised with just 2 colours, which work as 
huge gradient between two extreme values in our selection. This colour 
ramp can be changed by selecting the dropdown c, which is available 
also for categorized styling, but in my opinion is not necessary that 
much there. 
c,d – Color ramp selection – includes tens of others and more advanced 
colour ramps for using in your graduated styling (expand “All Color 
ramps”) section. The selection opens additional options worth our 
attention (Pic. 105). 

First of all, the multi-coloured ramp doesn’t mean fixed displacement 
of colours. Each ramp is equipped with “Stops”, that can be moved or 
deleted. The relative position is expressed in the percentage of a whole 
ramp strip visible just above. The default colour ramp comes in 
continuous coloration, which means, that all the hues penetrate each 
other subtly. We can also select the “Discrete” option instead and our 
colours will change abruptly. Not to mention, that the coloration of this 
ramp is just proposal! You can do what you want with colours, change 
them, make stops as much as you can and wherever you want to. 
Finally, you can save your ramp and append the final list of colour 
ramps (Pic. 
105). By 
saving the 
colour ramp 
you will be 
asked about 

assigning it 
to one of the 
4 groups 

available (Colorful, Grayscale, Showcase, Topology) 
making it easier to locate later. Other options here 
allow you to edit some existing colour ramp or 
create some colour ramp from scratch.  
e – Mode – the way of how the graduate classes 
must be calculated. There are a few options in 
which the whole range of our values can be split 
(Pic. 106). As default, the “Equal Count (Quantile)” is 
set, but we can choose also between: Equal Interval, 
Logarithmic Scale, Natural Breaks (Jenks), Pretty Breaks and Standard Deviation. 
f – Classess – specifying the total number of classes of our graduation. The default value is 5. 

Pic. 105 Colour ramp advanced selection with 
custom ramp saved. 

Pic. 106 Making classes by “Logarithmic scale”.  
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E. Labelling features – apart from styling important is 

defining the labels, which show a visual description of our layer. 
It’s the description expressed by the most important keywords 
like name, length and so forth. The default setting is “No labels”, 
but admittedly there is just one option for QGIS newcomer to use 
– Single Labels. For rule-based labelling the expression is 
required. In general labelling includes several sections where we 
can customize our text. At the beginning of your adventure with 
QGIS you just need to know the very basic one, where the font 
can be customized (Pic. 107). 
The “Text Sample” window shows how our label will look like. 
Below is the Text box, where you can change the fond and set the 
text size as default in Points, but they can be changed to 
Millimetres, Pixels, Meters at Scale, Inches and Map Units. The 
most important are Map Units, which visually correspond to used 

map scale (Pic. 110). Colour and opacity also are basic settings, 
which can be applied to our layer. 
The options available in the left sidebar apply to more advanced 

text customization. We will focus on some options offered by Placement and Rendering section. 
-> Placement – in general this section defines how the given label will be placed against the shape of our 

Pic. 100 Custom colour ramps saved.  

Pic. 101 Defining graduate classes by logarithmic scale.  

Pic. 107 The Label styling options in QGIS.  

Pic. 108 Basic label placement options in action: a) 
parallel, b) curved, c) horizontal.  
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feature. We can choose its correct position by positioning the label above or below the item, right or left of 
the item, overlay item with label and so forth. There is a multitude of combinations to play with, although 
now when you start using QGIS we can highlight just the most important ones (Pic. 108). 
The image below shows a piece of Placement section, with some important settings: 
 

 

a – Placement - The very first label defines the position of text against the feature (Pic. 108), in which the 
best is Curved, where the text firmly sticks to the shape of the item. When Parallel is used, the text is less 
“plastic” and can be placed diagonally when the feature “makes a turn” on the map. Horizontal basically falls 
right above the item. 
 
b – Allowed Positions – as default are “Above line”, but we can set our text online, blow line or depending 
on its position. 
c – Repeat – means how often our label will be repeated across the feature line. By default, it comes as “No 

Pic. 104 The placement of label against the feature: 
a – Parallel, b – Curved, c - Horizontal.  

Pic. 109 Basic label placement options with the most important highlighted.  

Pic. 110 The size of font against the map scale at different units applied.  
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repeat” which means, that the label will appear only once regardless the length of the line. By setting it as 
i.e., 300.0000 Meters at scale we should expect three labels along our 1km line separated by 300m.  

-> Rendering – the section which in general “is responsible” for showing the labels on our map (Pic. 106). 

a – Scale dependant visibility – determines until which scale the label will be visible. It’s very beneficial in the 
situation when we need to have our map clear for printing. When printing the general map, we don’t need 
labelling. They are needed mostly when we want some detailed view, therefore this option is crucial here. 
The maximum scale used here can be 1:1 or a bit smaller, whereas the minimum one is the most important. 
When going beyond the scale set in this box, the label is simply gone. 
b – Show all labels for this layer (including colliding labels) – useful when we want to show all the labels 
regardless of the density of various layers features. When this option is switched off, one of the labels yields 
another label in the vicinity. 
c – Show upside-down labels - as default set “Never” but it’s good to toggle to “When rotation defined” in 
the case when we want to use the label toolbar for rotating or changing their position manually. It won’t be 
covered in this text, as it’s mostly for viewers. 

 

Pic. 111 Basic label rendering options with the most important highlighted.  
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18. Exporting layer  
 

For QGIS user, who just analyses and views some produced project, exporting layer will be very important. 
The quickest option of exporting our layer is right-click on the layer -> Properties -> Export, where we have 
a few important options: 
- > Save Vector/Raster layer as… - typical saving option, which looks like below (Pic. 112).  
a) File details – Format, Name & Path and CRS. The most important here is the CRS system. We need to make 
sure, that it corresponds to our QGIS project! It often happens, that we import some layer (especially comma 
delimited after previous geocoding) with the WGS 84 coordinate system. Next our file doesn’t match the 
QGIS project with EPSG: 27700. Another point is, that the CRS is often used for reprojecting layer since QGIS 
3x is in use. 
b) Save only selected features – option when we have something selected across our layer. If not, it remains 
inactive. 
c) Select fields to export and their export options – very important option in the case when we want to “slim 
down” our file. When you don’t need some fields (attribute columns), you can simply untick them and they 
won’t be saved to the file. It’s good to know about some options below. When you need just 2 layers out of 

Pic. 112 Basic label rendering options with the most important highlighted.  
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10, quicker will be hit “Deselect All” and select just them 2 instead of 

unselecting other 8      . 
d) Extent (current layer) – when we need just a piece of layer, which is 
visible in our map, we can set the area in this section. The options are: 
- Coordinates (4 corners) as shown above 
- Current Layer extent – basically exports our whole layer as it is in the 
QGIS project 
- Map Canvas Extent – practically the same, because usually map canvas 
cover a whole world like OpenStreetMap 
- Calculate from layer – I guess the best option to choose from. If for 
instance we need the file ranged just within other layer which is smaller, 
this option will be the best. 
e) Add saved file to the map – it’s not necessary, although switched on 
in default. I wouldn’t change it, because emerging a new layer as a result 
of saving the current one states, that process has been successful. If not, 
an error should appear anyway. 
There are also other options in this box, but not necessarily for QGIS 
viewers/novices. 

-> Save Selected Feature As – exactly the same options as shown above 
(Pic. 112), although appear as separate saving option. In practise it’s just 
Pic. 112-point b) switched on. Anyway, it’s a very useful option. 

-> Save As Layer Definition File (.qlr) – this option allows us to retrieve 
the layer with styling. This file contains the pointer to the layer data 
source. 

-> Save as QGIS Layer Style file (.qml) – another way of saving the style file, but just in .qml extension. 

The export option in QGIS is also used for many conversions between the files. As you maybe know there is 
a lot of file formats in QGIS environment, but not all of them can be opened in various applications. 
Therefore, a user must know some way of conversion the files. QGIS seems to be a very good tool for it, 
because quite a few extensions can be opened here (imported) and exported under different format (Pic. 
113).  

In more complicated way the Geopackage file (.gpkg) can be saved. It’s not possible with this simple option 
described above. Because the Geopackage layer is usually comprised of more than 1 layer, we must create 
the “package” (Pic. 114).  

Pic. 113 File extensions available in the 
“Save as” option in QGIS.  
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This package can include up to all the layers belonging to our QGIS project. There is the “Package layer” tool 
in our Processing Toolbox, which can be run for this purpose. Next, we are selecting the layers, which must 
be included in our Geopackage file and simply clicking the “Run” button. The specificity of Geopackage file 
is ordering all the layers alphabetically regardless their initial order in our layer panel! Sometimes it might 
be disturbing if we want to have some specific layers on the top of others (like cable route at the top of 
driveway, land registry, and so forth). Good method for it is adding the prefix like 1,2,3 or A,B,C to the layers, 
which will mark the new order elsewhere the Geopackage file will be imported. 

19. Exporting map to file 
 
The quickest way of export any map produced in QGIS is in Project -> Import/Export. There are 3 options of 
exporting the map. Excluding the last one, which is export to the format .dxf and making it used in the CAD 
environment, the user can make it on the visual way by producing the raster file. There are 2 ways of export 
QGIS map to raster though – by using “Export map to image” and “Export map to PDF”. 
The first option – export map to image saves our image in the .png file including an auxiliary file with .pgw 
extension. It means, that we are receiving georeferenced .png file. It’s in the case, when we want to load the 
.png file directly to our QGIS map in another project. By having the geometry detail in the .png file, quick 
location of .png raster image in our map is possible. Otherwise, you would have to georeferenced this image 
manually, which obviously takes the time. It’s good to know about it then. The .png format is also 
georeferenced, so it can be plotted on random QGIS project easily at previously defined location. The export 
options for .pdf and .png files are quite similar. Regarding the georeferenced file, we don’t need to even 
think about it, as the “Append georeferenced information” option is set on as default (Pic. 115). That’s why 
the auxiliary .pgw file is created. If you need just pure .png image for print, you can switch this option off 
and the .pgw file won’t be generated. Other important settings, within the “Export map as image” option is 
highlighted in the image below (Pic. 115), though I guess most important is the extent of our image we want 
to generate. The default setting provides the visible bounds of our current map view expressed with the 
coordinates of the CRS defined in our QGIS project properties. The choice of our extent is quite wide, because 
we can stick to the particular layer used in our project or even draw our custom range in the map (Pic. 115). 

Pic. 114 Creating the Geopackage (.gpkg) file in QGIS.  
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The second feature is the Scale (II), which usually comes the same as set in the current map view. It’s still 
the moment when we can change it. Another thing, which regrettably always comes as 120 dpi is Resolution 
(III). The only method of how we can change the default resolution from 120 dpi to other is making the 

Magnifier value other than 100% (see Chapter 10, Pic. 39, 4). As we change the resolution the Output 

dimensions change accordingly.  
Last options to look at (IV) are “Draw active decorations” and “Append georeferenced information”. When 
we have “none” displayed, it means that no decorations have been applied to our map. The “Append 
georeferenced information” option was discussed earlier. Let’s focus on the potential decorations we can 
apply to this exported map image. 

Pic. 115 QGIS – Export map as image with important options highlighted.  
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Decorations in other words mean the map components, which are usually inherent in the typical map canvas 
like legend, scale, north arrow or grids. Decorations available in QGIS are: 
-> Grid – based on the current CRS coordinates (Pic. 116). 

 

A user can define the grid interval, type of grid and annotation options. Everything, which is needed to display 
the grid properly. 
-> Scale bar – very simple way of defining the map scale. Admittedly it marks just one section of distance, 
which is very poor, although it’s good to have something rather than “Not to scale” input in the corner (Pic. 
117). 

-> Image – refers rather to logo or watermark, which can be attached to our map image (Pic. 118). You can 
provide your own to the custom directory and use it. 

Pic. 116 QGIS – Grid decoration. 

Pic. 117 QGIS – Scale bar decoration. 
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-> North arrow – very useful element the same as the scale bar. Likewise in the case of Image decoration, 
we can provide our own .svg pattern for the north arrow symbology (Pic. 119). 

-> Title Label – simple way for adding title to our map (Pic. 120). 

Pic. 118 QGIS – Image decoration. 

Pic. 119 QGIS – North Arrow decoration. 
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-> Copyright Label – an option for adding copyright to our printed map (Pic. 121). We can also use the 
expression for it. 

 

-> Layout extent properties – works only when some print layout is in use. It’s rather subject for the last 
chapter of this publication. When we have already map opened in the print layout, the layout extent 
decoration shows the range of map within the main map canvas (Pic. 122). Moreover, we can apply the text 
label, which will display the name of layout and map included. 

Pic. 120 QGIS – Title Label decoration. 

Pic. 121 QGIS – Copyright Label decoration. 
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20. Printing map 
 
The final thing in our project is surely getting the product outside. 
Apart from exporting any layer to the different format, which allows 
to migrate our work between various GIS software, undeniably 
getting the map in printable version is the key thing within any range 
of work. In previous chapter just the simple and quickest way of 
getting map as image (which can be printed next) has been 
explained. This chapter is dedicated for exact explanations of how 
the user can print the QGIS map out with all relevant components. 
The most advantageous printing option can be found when we go to 
the Project -> New Layout in the Layout & Report section. There are 
also other options available, but useful just when some print layouts 
have been already created (Pic. 123). When we have already some 
print layouts created, they can be used via Layout Manager or 
Layout dropdown list. They are in fact the same, but the first one 
gives a way of small alterations like Duplicate, Rename, or Remove 
(Pic. 123).  
It's just a pure information, because I guess you have no print layout 
created at all, as you have already started working in QGIS. If your 
situation is different, and you are browsing some existing project, 
then knowledge about the print layout management presented on 
your left will be more useful. 
Assuming, that you have nothing to print your map, you must create 
a new print layout. The very first step is providing the unique print 
layout title and click OK. Instantly a user should spot the print layout 
window (Pic. 124) 

Pic. 122 QGIS – Layout extents decoration. 

Pic. 123 Print layout management in QGIS. 
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This working panel has a lot of options which must be discussed.  

I – Right-click on the layout – we have 5 options here, but most useful are: Undo, Redo and Page 

Properties. 

II – Page properties (Item properties) – give you options for changing paper size and 

orientation – frankly the most important settings here. 

III – Right-click on the sidebar – shows all panels and toolbars, which can be displayed in print 

layout. It’s not advisable to keep displayed all of them, because we are losing precious space for 
customizing our print layout area. The numeration 
below shows all the toolbars, which are already 
displayed as default. They all are discussed below: 

1 -  Actions Toolbar – there is a few options, which are 
needed for keeping all the features in correct order and 
placement across the whole layout. 
a) Lock selected items – freezes all items being 

currently in use. It’s crucial feature for our painstaking work in print layout, especially when we want 
to adjust correctly all the elements against i.e., some frame border, etc. Sometimes it’s hard to adjust 
another map element, when lies in the vicinity. As a consequence, we are accidentally picking up the 
other element, which have been already adjusted. It’s troublesome and extends our work 
significantly. Therefore, locking that element is important. It prevents it from unforeseen changes of 
the position. 
b) Unlock all items – unlock all elements provided to our map. 
c) Group items – likewise group option i.e., in MS Excel – we can group map elements previously 
selected. Selection cannot be done by holding the Ctrl button. We can draw the box on out layout 

Pic. 124 Print layout working panel in QGIS. 

Pic. 120 The components of Action Toolbar in QGIS 
print layout. 

Pic. 125 The Action toolbar components in QGIS print 
layout. 
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area which will include the map elements within. When items are grouped, the user can edit all of 
them simultaneously by dragging to other position, changing relative size, and so forth. 

d) Ungroup items – ungroups all the items 
e) Raise selected items – in other words moving them up (above). The other options as usual: Lower, 
Bring to the front, Send to back. 
f) Align selected items – Left, Top, Bottom, Right, etc. 
g) Distribute edges to the item equidistantly – displaces the random edges of the selected item 
against the options shown below (Pic. 126). 

h) Resize item width to match the shape of selected item – all the options along with the example are 
provided in the image below (Pic. 127). Both g and h points represent the selection of all the items 
across our print layout. These options are rather beneficial for adjusting some specific element of our 
map to another element with the same size or distribution. In this case we can gain some time by 
omitting the alterations of some dimensions.  
Concluding all the options described here can be found in the Main toolbar -> Items. The main 
toolbar is located at the very top of our print layout. The same situation applies for other toolbars 
listed and described in this chapter. 
2 – Atlas toolbar – mostly inactive, because it requires toggling the “Generate an atlas” option. It’s 
the thing more for advanced QGIS users. 

Pic. 126 Distributing top edges to the item (layout) equidistantly. 
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3 – Layout toolbar – the toolbar dedicated for exporting our “product” which at this stage should be 
prepared for printing. 

We have the options 
known already from 
other software, which are 
listed below. 

 

a) Save project – simply saves the progress of our work on the current print layout. 
b) New layout – another way where we can create new layout at the same basis as discussed 
earlier. 
c) Duplicate layout – duplicated already existing layout with a whole job progress made to it. 
d) Layout manager – closes already opened print layout and opens the Layout manager discussed 
earlier. 
e) Add items from template – opens Windows dialog box, from which you can select some QGIS 
layout templates (.qpt files) from some directory and load them to the existing print layout. It’s 
also an alternative for opening an existing print layout by loading the .qpt file into a blank (new) 
print layout. 

Pic. 127 Resizing width of items to match the narrowest shape of the item. 

Pic. 128 The Layout toolbar components in QGIS print layout. 



72 
 

f) Save as template – saves our print 
layout in .qpt file. 
g) Add pages – inserts new pages to 
our print layout. In default we are 
working on just 1 page. It can be 
always changed by using Atlas option 
or adding another page. The page 
options are exactly the same as 
discussed previously. We can change 
its dimensions and orientation, 
which can be different than our first 
page. It depends on what we need. 
We can also remove the page when 
needed. 
h) Print layout – prints our layout, 
although it’s not an instant printing. 
Before entering the print properties, 
QGIS makes the layout checking, 
which defines the validity of our 
work. If something is missing or isn’t 
linked properly, then an error is 
thrown with potential suggestions of 
how to fix it (Pic. 130). 
Obviously, a user can ignore them 
and hit OK, which eventually 
redirects him to print properties, 
however it’s a moment, when he can 

still consider some 
way of improving his 
tremendous work. 
The same “Checking 
layout” appears by 
export options 
discussed later. 
i) Export as image – 
exports our work into 
the .png file. 
j) Export as SVG -   an 
interesting option of 
exporting our map to 
scalable vector 
graphic (.svg file), 
making it possible to 
display in the HTML 
environment. 
k) Export as PDF – 
exports our map to 
the .pdf document. 
l) Undo recent 

Pic. 130 Checking layout before printing options in QGIS print layout. 

Pic. 129 New page added to our print layout and right-click options. 
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changes – we can undo our work by 1 step. 
m) Redo  - repeats changes undid previously. 

4 – Navigation toolbar – a few options which help us to work with the visibility of our print layout 
(Pic. 131). 

a) Zoom in – enlarges our map by 2x. 

b) Zoom out – zooms out our map by 2x. 

c) Zoom to 100% - gives a real size of our print layout. 

d) Zoom full – adjusts zoom level to our print layout window. 

e) Refresh view – updates our print layout view. 

 
 

5 – Toolbox – set of tools, which are used for creating 
and customizing our map for printing or export (Pic. 
127). 

        a) Pan layout – pans the layout in the place where we want. Used only for the  
        zoom other than full. If full zoom applied there is nothing to pan, as the view          
        falls roughly at the centre of our print layout page. We can use this option for  
        dragging our map too. 
        b) Zoom to selection – zoom in to the area selected by user. We are marking our  
        area by the box and QGIS makes it enlarged for entire screen even if the view is far       
        beyond 100%. It can be pixelated in this case (Pic. 133). 
         c) Select & Move item -   

 makes the selection 
 and moves the given 
 item where a user 
 wants to. 

   d) Move item content – a 
 very important 
 feature, which allows 
 us to drag the map 
 inside of the map 
 element. It does 
 happen quite often, that the map 
 rendered in the print layout 
 doesn’t correspond to the view 
 we want to print out. Therefore, 
 running this option gives us an 
 instant chance for alteration the 
 map view for our work purposes 
 (Pic. 134). 

   e) Edit nodes item – this option is   
 applicable only for newly created 
 shapes in our print layout. It 
 doesn’t cover regular shapes 
 Ellipse, Triangle, Circle), just only 
 Polygons, Polylines and Arrows 

Pic. 131 The Navigation toolbar 
components in QGIS print layout. 

Pic. 132 The Toolbox components in 
QGIS print layout. 

Pic. 133 Zoom to selection in QGIS print layout. 
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 (Pic. 135). 

Pic. 134 Move item content in QGIS print layout. 

Pic. 135 Adding (drawing shapes) and editing node items in QGIS print layout. 



75 
 

      f) Add 3D map – rather not used for QGIS newbies. It’s the option for providing 3D map into our 
       print layout. 
     g) Add map – the element, which will be discussed below. For now, just important to know where 
       a user can add his QGIS project map to print layout. When this option is clicked, we need to     
       draw a box across the layout, within bounds the map will be rendered as shown below (Pic.  
       136). 

 

   h) Add picture – works at the same basis as adding map, but instead of rendering map you will    
    have just blank box, to which our custom image can be imported (Pic. 137) or .svg image from 
       QGIS local directory. 
   i) Add label – simply creates text box in the print layout. 
   j) Add legend – creates default map legend in print layout. Initial legend content includes    
   everything from our QGIS project. 
   k) Add scalebar – creates the scalebar on our map. 
   l) Add north arrow – creates north arrow on our map. 
  m) Add shape – we can create the regular shape (Rectangle, Circle and Ellipse) on our print layout. 
 Again, the regular means, that vertices cannot be edited by the option described earlier (e, pic. 
 135). 

Pic. 136 Adding map to QGIS print layout. 

Pic. 137 Adding image to QGIS print layout. 
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 n) Add arrow – creates arrow on our map. 
 o) Add node item (Polygon or Polyline) – the option for creating a custom shape on print layout 
 (Pic. 135). 
 p) Add HTML – adds the HTML frame item to our map, but it’s rather too advanced option for 
 newbies. 

 q) Add attribute table – this option brings the whole attribute table to our print layout (Pic. 138). 

              r) Add fixed table - likewise in Microsoft Word we can add the custom table for storing some data 
 in the print layout. 

 

Map item features 

 

So far, we have discussed all the features possible to add from Toolbox. Basically, all these options have 
some default settings, which can be awkward for us when unchanged further. All the edits, alterations, and 
adjustments are to be found in the “Item properties” option, which is togglable when right-clicking on some 
feature (Pic. 139). This is the core thing of current chapter, which must be discussed separately, although 
not all option will be highlighted. We are focusing on the most necessary for viewing purposes.  The “Item 
properties” option is available only when the given feature is selected, as shown in the image below (Pic. 
139). The other option is right click on the left sidebar and switching on “Item properties panel” as discussed 
earlier, although without previous selection of the item it will be displayed empty. The Item properties panel 
usually can be docked on the right side, but if we want to have it taller and see a multitude of options at 
once it’s vital to pop its out and place even outside of the main print layout window (Pic. 139).  

I – Map – one of the most important properties and it shouldn’t wonder anyone several options available 

here (Pic. 140).  
1 – Main bar – a few handy options for map overview. 

Pic. 138 Adding attribute table to QGIS print layout. 
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a) Update map preview – refreshes our map in print 
layout. 

b) Set map extent to match main canvas extent – 
adjusts the map view to the view visible in the main 
QGIS project. 
c) View Current Map Extent in Main Canvas – the same 
option but in opposite direction. The map canvas in 
QGIS project is adjusted to the map visible in print 

layout. 
d) Set map scale to match main canvas map scale – 
slightly different option from described above, where 
we had the same map view. In this case the map scale 
is matching. 
e) Set Main Canvas to Match Current Map Scale – the 
same option in the opposite direction. 
f) Bookmarks – an option for saving current map view 
as the bookmark. 
g) Interactively edit map extents – the same option as 
discussed earlier. If you are unhappy with the current 
map view, you can drag the map within its boundary. 
h) Labelling settings – mainly define the minimum 
distance from map edges where the label can be 
placed.  

2 – Main properties – the information about map scale, which is always subject to change and rotation when 
necessary. You can also find the information about the CRS, although changing it it’s not advisable. 

Pic. 139 Launching Item Properties in QGIS print layout. 

Pic. 140 Map item properties in QGIS print layout. 
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3 – Layers – the most important option is “Lock layers” 
which prevents the map layers from disappearance, which 
might happen from time to time. 
4 – Extents – marking coordinates of all the map corners 
defined by Xmin/max and Ymin/max 
5 – Controlled by Atlas – usually inactive. We can use it 
when the Atlas option is enabled. 
6 – Grids – option for adding one (or more) grids to our map. 
They can be added by using the “+” symbol. We can have 
an additional set of options here (Pic. 141), where we can 
adjust mostly their interval and label the coordinates. These 
both options are CRS-based unless changed from Map Unit 
to other value like Centimetres. Labels falls in the middle of 
coordinate grids, therefore it’s advisable to create another 
set of grids and offset them slightly to display labels more 

nicely by keeping line style invisible. 
7 - Overviews – another cool option, where apart from the major map we can have the overview in around 
10x smaller scale (subject for setting), which will place our current view in the boundary (Pic. 142). 

8 – Position and size – defines the rough place of our map. We can set the page of our print layout (as default 
the first page) where the map can be placed and its XY position against the reference point defined 
underneath. The default unit is Milimiter. Moreover, you can also Lock aspect ratio, which is needed to keep 
proportions of your map when making it larger or smaller. 
9 – Rotation – defines the rotation our map, the same as discussed above. 
10 – Frame – it’s something optional, which can be set up. The problem is that the bounds mark roughly the 
map edges. When bigger thickness is applied, the most extremal areas of the maps are hidden by the frame 
(Pic. 143). 

Pic. 141 Map grid - important properties in QGIS print 
layout. 

Pic. 142 Map overview in action. 

Pic. 143 Map edges hidden by the thick frame applied. 
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11 – Background – defines background colour below the map canvas. 
12 – Item ID – displays the name of our map (“Map” as default), which can be also further displayed as the 

label in decoration (see Chapter 22, Pic. 122). 

13 – Rendering – the way of how our map can be displayed for print or export or maybe we need to 

exclude it from export? (Pic. 144). 

We can set there the Opacity of our item as well as apply some Blending mode (image filter) emphasizing, 
fading, or inverting our element coloration. 
14 – Variables – just information about metadata. 

II – Picture – if we decide to place some image, the properties will be very similar to discussed above, but 

the list will be shorter. You will have an opportunity to change the: Image rotation, Position and size, Frame, 
Background, Item ID and Rendering. Interesting option is SVG parameters, which is active when instead of 
the raster image you will decide for placing some SVG signature on your map (Pic. 143). 

Pic. 138 Setting up the map frame in QGIS print layout. 

Pic. 142 Item rendering in QGIS print layout. 

Pic. 143 Adding .svg signature to your print layout. 
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Admittedly this is something, which you might forgotten when working on your QGIS project and instead of 
turning lot of stuff upside (redefining styling, etc) down you decided to use some signatures. 

III – Text Label – First very important map element, in which we can set some map name or simply put 

text to our map. The text is displayed twofold, as normal and rendered as HTML (Pic. 144). 

 

Basic options are also similar to map options discussed earlier. In the case of the label the most important is 
Appearance, where we can define the Font type, Font size and Alignments against the box. Here is a nice 
trick to apply. If you need to have the map title centred exactly against the map item, stick your label box to 
the opposite edges of your map and align your font center. When you plan to put more text and justify it, 
then rendering HTML will be beneficial, where you can provide relevant HTML snippet for this purpose. 

IV – Legend – the most important map element, which always comes along with the map. There are some 

crucial options here for customizing the legend display as best and most optional as possible. All of them are 
shown and explained below (Pic. 145). 

1 – Main properties – include the legend title, the map to which our legend is assigned and some visual stuff 
like symbol arrangement (to left or to right). Another feature, set on as default is “Resize to fit content”, 
which controls the legend width to the length of the text. Interesting option is “Wrap text on” which requires 
adding some specific character occurring in our legend text or formula. As a result, our legend text will be 
broken down into 2 lines. 

2 – Legend items – the most crucial element, which makes the style symbols used in QGIS project visible 
next to our print layout map item. 

Pic. 144 Customizing text label in QGIS print layout. 
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As default, the “Auto update” option is switched on. It means, that the legend is synchronized with our layer 
panel in QGIS. Unless some layer is not deleted it will be included in the legend! Switching off the layer from 
the panel doesn’t work in this case. We can always switch this option off and play with the legend inputs 
manually by using the options below in the panel. 
a) Move item down – moves our legend item down by 1. 
b) Move item up – moves our legend item up by 1. 
c) Add group – by clicking this button, the empty group is created at the very bottom, to which the legend 
items can be dragged. 
d) Add legend item – in the case when we have autoupdate switched off. 
e) Remove legend item – clears out the element, which is not needed. 
f) Legend items properties – here we can change the name of the selected legend item. 
h) Add an expression to the vector layer and each child’s symbol layer – for advanced users. It can be applied 
for example when we want to have to change number format to scientific and something like this. 

i) Show feature count for each class of vector layer – the same option as explained earlier (Chapter 12, Pic. 
53), now we can have the values displayed in the legend. 

 
It's worth to mention another 2 features below, especially the first one: 
“Only show items inside linked map”, which shows just these features, which are displayed within the map 
in our print layout instead of a whole QGIS project (Pic. 146). 

Pic. 145 Legend properties in QGIS print layout. 



82 
 

 
3 – Fonts and text formatting – the font settings for each text placement across the legend (Title -> Group -
> Subgroup -> Item). Alignment also can be set here. 

4 – Columns – important option for our legend display. As default we have everything in 1 column, but 
usually it’s advisable to split the items between 2, 3 or even 4 columns (Pic. 147). 

5 – Symbol – defines symbol width and height. 
6 – WMS Legend Graphic – here you can set the overall legend dimensions, although bear in mind, that if 
the “Resize to fit content” option is active it won’t work properly. 
7 – Spacing – determines visual spacing between title, group titles, subgroup titles and item titles. 
8 – Other options discussed by Map item. 

V – Scalebar – beside Legend another most important element of our map, which helps us get around 

with the distances shown. The major options are listed below (Pic. 148). 

1 – Main properties – the selection of map to which the scalebar is applied and the visual type of scalebar 
(Pic. 149). 

Pic. 146 Legend showing only items inside the linked map. In this case just OpenStreetMap canvas. 

Pic. 147 Legend split by 5 columns in QGIS print layout. 
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There are 5 types of scale layout available and numeric scale. All the options you can see above (Pic. 149). 

Pic. 148 Scalebar options in QGIS print layout. 

Pic. 149 Scalebar style options in QGIS print layout. 



84 
 

2 – Units – as default it comes in Meters, but 
everything is customizable.  
3 – Segments – as you can see in the 
screenshot above (Pic. 149) the default scale 
is divided by 4 segments without the 
backward segment (left). Here is the place 
where we can change it. Usually, especially 
on traditional maps the backward segment 
used to be fractionated by 10 against the 
others to measure the distance more 
precisely (by using compass). Here we don’t 
need it that much, but it’s good to know 
about it. 
4 – Display – determines the margins from 
the scale box as well as label margin, which 
seems to be much more important. By 
changing the label margin, a user changes 
the distance of the label from the scale body. 
5 – Fonts & Colors – customization of the 
scale appearance. Black & White comes as 
default. 
6 – Other options already explained. 

VI – North Arrow – the properties are 

quite similar to the image (Pic. 150). 
Here the most important setting is surely the 
visual changing of the north arrow symbol, 
which is pure .svg graphic from QGIS 
directory. By expanding “Search Directories” 
option a user can change it quickly. In the 
SVG parameters we can do the same with 
the coloration. 

VII – Attribute table – the last element 

classified as one of the most important, 
which can be found in the map or being 
precise next to the printed map. The option 
sections are listed below as usual and 
presented later (Pic. 150). 

1 – Main properties – define the source and 
layer of our attribute table attached. We can 
refresh the attribute table view and adjust the specified attribute columns to its general appearance. 
2 – Feature filtering – defines the maximum number of rows to be displayed (default set to 30). Moreover, 
a user can remove duplicate rows from table if exist any or show just features visible on the map.  
3 – Appearance – determines the settings of cell margins, the header appearance or background colour. 
4 – Show grid – the lines bounding the cells likewise in Microsoft Excel. We can change their thickness and 
coloration here. We can define which lines do we need vertical, horizontal or both. 
5 – Fonts and Text Styling – the place for customizing font, colour, and alignment both for Table Heading as 
well as Table contents. 

Pic. 150 Scalebar style options in QGIS print layout. 
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6 – Frames – this section falls inside the “Font and Text styling” but 
its purpose is different, as it determines the overall size of our 
attribute table. It’s essential to use especially when we want to extend 
our attribute table to the next page and print it separately. 

Items panel 

The last important matter to discuss in this chapter is using the Items 
panel. It’s something different from Items properties, which applies 
to each feature separately. The Items panel can be switched on from 
the sidebar after right-click (Pic. 124 III).  Next you should see the 
window including the list of all elements included in the print layout 
(Pic. 152). This list comes with two additional options, where the 
option A is the item visibility on our print layout page and option B 
informs us about locking this item or not. When the feature is locked, 
then the same option as discussed earlier (Pic. 125, b) is applied, 
although here you can lock and unlock more features quite quickly by 
ticking on/off. 

Pic. 151 Attribute table options in QGIS print layout. 

Pic. 152 Items panel in QGIS print layout. 
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Legend 24, 30, 32, 54, 80 
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Menu 12 
Move 26-27, 43, 46, 81 
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Pan 12, 17, 43 
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Paste 44 
Path 29 
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Plugins 7,9, 17 
Polygon 30 
Print 68-70, 72 
Project 3, 13, 40 
Properties 25, 36, 69, 82 
Preview 76 

Radius 31 
Raster 49 
Redo 19 
Refresh 15 
Reload 44 
Rename 26 
Render 22, 29, 59, 79 
Reset 45 
Resize 70 
Rotation 22, 78 
Save 12, 18, 44, 53, 60, 71-72 
Scale 21, 29, 38, 40, 64, 82 
Search 20 
Selection 15, 20, 25, 30 – 33, 39, 
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Settings 12, 34, 37, 39-40 
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Snapping 39 
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Styling 13, 24, 27 50-56 
Status Bar 5 20-21 
SVG 17 
Switch 42-43 
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Text 17, 82 
Toolbar 5, 13-20, 41, 73 
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